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Starting Setup
To install Microsoft Digital Image 2006 Standard Edition, you must be running 
Windows 98, Windows Millennium Edition, Windows 2000, or Windows 
XP or later. On Windows 2000 and Windows XP systems, you must have 
administrative privileges. For information regarding privileges, please refer to 
the operating system Help. 

On most computers, Microsoft Digital Image setup will begin automatically 
when you insert the Microsoft Digital Image CD into your disk drive.

To begin automatic set-up:

 1. Turn off any antivirus software that you’re using, and close any programs 
that are running. 

 2. Insert the Microsoft Digital Image 2006 Standard Edition CD into your 
disk drive. The Installation Wizard begins automatically. 

If the above procedure does not start the setup process, you can start it 
manually.

To begin setup manually:

 1. Turn off any antivirus software that you’re using, and close any programs 
that are running.

 2. Insert the Microsoft Digital Image CD into your disk drive.
 3. Click Start, and then click Run.
 4. If your CD-ROM drive is listed as letter D, type d:\setup.exe. 

If your CD-ROM drive has a letter other than D, replace D with the  
correct letter when you type the path.

 5. Click OK. 
The Installation Wizard begins.

Installation 
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Completing the Installation Wizard
The Installation Wizard will show you a series of dialog boxes that provide 
setup status and some installation preference options. For most users, the 
default preferences will be appropriate. Information about the different setup 
options is provided below.

Installation Folder Dialog Box
The Installation Folder dialog box allows you to choose where the program will 
be installed on your computer. To install the program to a folder other than the 
folder in the Installation folder box, do one of the following:

• Type a different path in the Installation Folder box.
• Click Change, select a folder in the Change Installation Folder dialog 

box, and then click OK.

Note that some files will be installed to the Program Files drive even if you 
choose to install the program to a different drive. 

Installation Options Dialog Box
The Installation Options dialog box allows you to choose between Typical 
installation and Full installation. 

• Typical installation takes up less space on your hard drive, and is recom-
mended for most users. With Typical installation, you will have to insert 
the Microsoft Digital Image CD in your CD-ROM drive to use some of 
the projects and clip art while you are using the program.

• Full installation copies all of the Microsoft Digital Image projects and 
clip art to your hard drive, so you will not have to reinsert a Microsoft 
Digital Image CD while you are using the program. Look under Descrip-
tion for the disk space required for this option.
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Special Circumstances

Upgrading from a Different Microsoft Digital Image Product
If you already have a Microsoft Digital Image product installed on your 
machine, any one of several situations may occur when you try to install 
another Microsoft Digital Image product: 

• Previous versions If you have a Microsoft Digital Image product previ-
ous to the 2006 edition already installed, installing a 2006 product will 
make both programs available on your computer.

• Upgrade from another 2006 product You can install a Microsoft Digital 
Image 2006 product that has more features than a 2006 product already 
installed. The version of Microsoft Digital Image with fewer features 
will be uninstalled automatically before the new installation begins. Your 
pictures and projects will not be deleted.

• Blocked downgrade If you have a Microsoft Digital Image 2006 product 
installed, you will not be able to automatically install a 2006 product with 
fewer features. To install the version with fewer features, you must first 
uninstall the version with more features.
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Reinstalling or Removing Microsoft Digital Image 
If you are having problems running Microsoft Digital Image, reinstalling the 
program may help it to run better on your computer.

You should not attempt to remove Microsoft Digital Image by deleting the 
program files from your hard disk. Instead, use the Microsoft Digital Image 
Installation Wizard to properly uninstall the program.

To remove or reinstall Microsoft Digital Image on Windows XP:

 1. Log on to the computer as an administrator.
 2. From the Windows Start menu, click Control Panel.
 3. Click Add or remove programs.
 4. From the list of installed programs, click the version of Microsoft Digital 

Image you want to remove or reinstall. 
 5. Click Change/Remove. 

The Installation Wizard opens.
 6. Follow the instructions on the screen.

To remove or reinstall Microsoft Digital Image from Windows 98, 
Windows 2000, or Windows Millennium Edition:

 1. From the Windows Start menu, point to Settings, and then click Control 
Panel.

 2. Click Add/Remove Programs.
 3. From the list of installed programs, click the version of Microsoft Digital 

Image you want to remove or reinstall.
 4. Click Add/Remove. 

The Installation Wizard opens.
 5. Follow the instructions on the screen.
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Congratulations on your purchase of Microsoft Digital Image Standard. It is 
actually composed of two programs: Microsoft Digital Image Standard Editor 
and Microsoft Digital Image Standard Library.

Microsoft Digital Image Standard Editor provides editing features such as 
selection tools, red eye removal, and colour and contrast adjustments to help 
you get professional editing results quickly and easily. When you’ve finished 
editing your photos, it’s a simple process to create prints or share your pictures 
through e-mail. 

Microsoft Digital Image Standard Library is a powerful tool for organising, 
finding, and viewing your pictures. You can use the program to locate your 
pictures using folders or by browsing labels, flags, and ratings. You can view 
your pictures with the Library’s full-screen slideshow viewer. 

What You’ll Find in This Book
The Microsoft Digital Image User’s Manual introduces you to some important 
features in Microsoft Digital Image: how to get images into the program, edit 
images, add effects and borders, create projects, and print. 

This book also provides an overview of some of the most important concepts of 
digital imaging. 

The final section of this book offers a selection of articles on digital photogra-
phy with plenty of sound advice from professional photographers. 

Other Helpful Resources
This User’s Manual is not an exhaustive resource for everything you can 
do in Microsoft Digital Image. For step-by-step instructions about all of the 
program’s features and projects, check out the online Help system, available 
from the Start-up Window or the Help menu. Or, for a demonstration of some of 
Microsoft Digital Image’s key features, watch one of the Demonstration Videos.

Digital photography is exciting and fun, and Microsoft Digital Image makes it 
easy to get professional results. We’re confident that Microsoft Digital Image 
will be an enjoyable part of your digital-imaging experience.

Welcome to Microsoft Digital 
Image Standard
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Microsoft Digital Image makes it easy to import and open your pictures 
quickly. To import pictures from your camera or removable media to your com-
puter, use the Import Pictures Wizard. This wizard is designed to streamline 
the file transfer process, allowing you to name the picture files and destination 
folder. To open pictures for editing, use the file browser. The file browser 
displays thumbnails of all your pictures, so you can quickly choose the ones you 
want. 

Importing Pictures
The Import Pictures Wizard is a convenient way to transfer pictures and video 
clips from your digital camera, scanner, flash memory card, or some other 
storage location to your computer.

Launching the Import Pictures Wizard automatically 
Windows Millennium Edition and Windows XP can automatically detect 
compatible cameras and other photo media such as photo CDs. This detection 
should occur when you:

• Connect a compatible camera to the computer and turn on the camera.
• Connect a compatible scanner to the computer and turn on the scanner.
• Connect a compatible card reader to the computer and insert media.
• Insert a photo CD, DVD, or other storage media into a drive on the 

computer.

This automatic detection feature is only available on computers running 
Windows Millennium Edition or Windows XP.

To set Windows to launch the Import Pictures Wizard automatically:

 1. Connect your compatible camera, scanner, or other device to the com-
puter, and then turn on the camera or device. 
- or - 
Insert the removable media into a drive or card slot on the computer.

 2. When Windows detects the picture files, Windows will ask you what you 
want to do with the pictures.

 3. Click Import pictures to my computer using Microsoft Digital Image 
Import Wizard. 

 4. Check Always do the selected action.
 5. Click OK.
 6. Click the device you want to use, and then click OK.

Opening and Importing Pictures
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Starting the Import Pictures Wizard manually
If Windows does not automatically detect your device or other media, you can 
start the Import Pictures Wizard manually.

To start the Import Pictures Wizard manually:

 1. Start Microsoft Digital Image.
 2. On the File menu, click Import Pictures.
 3. Click the device you want to use, and then click OK. 

- or –
 1. Start Microsoft Digital Image Library.
 2. On the File menu, click Import Pictures and Videos.
 3. Click the device you want to use, and then click OK.

Opening Pictures for Editing
With Microsoft Digital Image, you can open pictures for editing from a variety 
of sources, including your computer, storage media, and most cameras and 
scanners.

Using the file browser
You can use the file browser to locate your pictures and open them for editing. 
The file browser can be used to open pictures from a large number of locations, 
including the following:

• The hard drive on a computer.
• An external hard drive.
• A digital camera that is a USB Mass Storage Class device. (A USB Mass 

Storage Class device works as a “virtual drive,” letting you browse and 
open photos from the device as you would from a hard disk or floppy 
disk.) Although you can open pictures from a camera in this way, you will 
probably prefer to use the Import Pictures feature.

• A card reader.
• A USB drive.
• A photo CD or DVD.
• A floppy disk.
• A network location.
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This picture identifies the main features of the file browser:

 1. All Files tab  Click the All Files tab to view the folder structure on 
your computer. Click a folder to display its contents and subfolders. The 
folder structure includes internal and external drives on your computer, 
including disk drives, card readers, and USB Mass Storage Class digital 
cameras.

 2. Microsoft Digital Image Library tab  Click the Microsoft Digital 
Image Library tab to find any picture you have catalogued in the 
Library. You can also use the Library’s View By and Group By features 
to make it easier to find the pictures you want.

 3. MSN Groups tab  Click the MSN Groups tab to open pictures that you 
have stored on MSN Groups.

 4. Look in box  Displays the name of the current folder selected on the All 
Files tab. 

 5. View menu  Use this menu to change the way the image files are 
displayed.

 6. Thumbnail size slider  Move the slider to change the size of the thumb-
nails.

 7. File name box  Displays the file name of a selected thumbnail.
 8. Files of type menu  Use this menu to change the types of image files to 

be displayed.
 9. Thumbnails  Small versions of your photos stored in the current folder.
 10. OK  Opens the selected thumbnails.
 11. Cancel  Closes the file browser without opening any photos.
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To open pictures with the file browser:

 1. If opening pictures from a USB Mass Storage Class camera, read your 
camera’s documentation and make sure that you have installed the 
camera’s software and drivers properly. Make sure your camera is 
turned on and connected to your computer.

 2. On the File menu, click Open.
 3. Click the All Files tab.
 4. In the Look in list, click the drive, folder, or network location that 

contains the picture you want to open.
 5. In the folder list, locate and open the folder or location that contains 

the pictures. 
Thumbnails of pictures in that folder appear in the right pane.

 6. Select the picture you want to open. To select multiple pictures, 
press CTRL as you click the thumbnails.

 7. Click OK.

File formats 
compatible with 
Microsoft Digital 
Image
Microsoft Digital Image 
can open photo files 
in any of the following 
formats:

• Adobe Photoshop 
(.psd)

• Enhanced Metafile 
(.emf)

• EPS (.eps)

• FlashPix (.fpx)

• GIF (.gif)

• Home Publishing 
(.php)

• JPEG (.jpg)

• Kodak Photo CD 
(.pcd)

• PC Paintbrush (.pcx)

• Picture It! (.png, .php, 
.mix, .fpx)

• PNG (.png)

• TIFF (.tif)

• Targa (.tga)

• Windows Bitmap 
(.bmp)

• Windows Metafile 
(.wmf)
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Opening pictures from other cameras
If your camera does not show up as a drive in the file browser, it is probably 
designed to work using TWAIN or WIA support. For many cameras, Microsoft 
Digital Image works with TWAIN and WIA and your camera’s software so that 
you can open photos directly into Microsoft Digital Image.

To open photos from a camera that uses WIA support:

 1. Make sure that you have installed all the drivers that came with your 
camera. 

 2. Connect your digital camera to your computer, and then turn on the 
camera. 

 3. On the File menu, click Import Pictures. 
 4. If more than one device appears in the dialog box, click the one that 

represents your camera.  
 5. Click the pictures you want to import. If you want to import more than 

one picture, press CRTL as you click the pictures. 
 6. Click Next.
 7. The pictures are copied to the My Pictures folder on your hard drive. 

Using your 
camera’s software
Some digital cameras—
especially older models—
may not function as a 
virtual drive or be TWAIN 
or WIA compliant. For 
these cameras, use the 
software provided by 
the camera to download 
the photos to a folder 
on your computer. Then 
open them with the file 
browser.
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Troubleshooting tips for opening pictures from a camera
• Your camera must be connected and turned on before you start the digital 

camera task, or it will not appear in the list of cameras and drives. 
• If you’ve connected your digital camera to your computer, but can’t see 

your pictures, make sure the connections are secure, the camera is turned 
on, and the batteries are charged. The camera might not start download-
ing if its batteries are low on charge. Some cameras are equipped with an 
A/C adapter that you can use instead of batteries. 

• If your camera does not appear in the list of cameras and drives, or if you 
receive an error message when you click Download, start your camera 
software from the operating system Start menu. 

• For more information about downloading photos using the software 
included with your camera, consult your camera’s manual. 

Opening pictures from a scanner
Microsoft Digital Image supports two types of scanner formats: TWAIN and 
WIA. If your scanner doesn’t use a TWAIN or WIA interface, you need to use 
the software designed specifically for the make and model of your scanner. 
Many scanner manufacturers provide free updates to their drivers on the Web.

To connect your scanner

 1. Install the software that came with your scanner. 
 2. Turn off your scanner and computer. 
 3. Attach the connector cable from your scanner to your computer. 
 4. Turn on your scanner and computer. 

Once the scanner is connected and recognised by your computer, you’re ready  
to scan.

About TWAIN  
and WIA
TWAIN is interface 
software that allows 
communication 
between a camera and 
your computer. Many 
digital cameras come 
with a TWAIN driver. 

WIA is a newer interface 
that works similarly 
to TWAIN, but often 
provides more control 
over the device. WIA is 
compatible with TWAIN, 
but is only available 
on some computer 
operating systems.
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To scan a photo with a flatbed TWAIN or WIA scanner:

 1. Connect your scanner to your computer, and then turn on the scanner. 
 2. Place your picture on the scanner. 
 3. On the File menu, click Import Pictures. 
 4. If more than one device appears in the dialog box, click the one that 

represents your scanner.  
 5. Depending upon the type of scanner you have, you will either see the 

Scan Picture pane or the Import Pictures Wizard. 

If you see the Scan Picture pane:

 1. Select your scanner from the list.
 2. Choose the Automatic Scan option from Click a scanning method.
 3. Click Scan.

If you see the Import Pictures Wizard:

 1. If you want to immediately open the scanned picture for editing, click 
Open the picture for editing. 

 2. Click Next. 
 3. Select a place on your hard drive where the scanned picture will be stored 

and specify a file format. The default JPEG format is usually an excellent 
choice for scanned pictures.  

 4. Select a scanning method. Most of the time, you should choose  
Automatic Scan to get a high quality, colour picture.

 5. Click Next.
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Opening a Photo Sent Through E-mail
Many friends and family members enjoy sending photos through e-mail.  
When you receive photos through e-mail, you can save them to your computer 
and then work on them with Microsoft Digital Image. 

Many photos sent through e-mail are low-resolution photos, which are not  
suitable for large prints. But low-resolution photos may be fine for online  
viewing or printing at small sizes.

To open a photo sent through e-mail:

Use your e-mail program to save the photo to a folder on your computer. Save 
the photo to a folder that will be easy for you to locate later, such as the My 
Pictures folder.

 1. In Microsoft Digital Image, click Open on the File menu.
 2. The File Browser dialog box opens.
 3. Click the All Files tab.
 4. On the All Files tab, browse to the folder containing the photo, and then 

click the folder. 
 5. Select the photo, and then click Open.

Can this photo  
be printed?
To find out if a photo has 
enough resolution to 
print, see the “Selecting 
a Print Size” section of 
the “Saving and Printing 
Pictures” chapter.
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Opening a Picture from a Web Page
When you surf the Internet, you may come across pictures that you would like 
to use in your projects. Unless the Web site uses image protection, you can cap-
ture these images and use them for your own projects. Keep in mind, though, 
that even unprotected pictures may still have a copyright and you should have 
the permission of the Web site owner before saving and using pictures you find. 
Also, Web pictures are usually low resolution, so they may not be suitable for 
printing. But you could still use the images in a project to be viewed online.

To open a photo from a Web page:

 1. Make sure that both Microsoft Digital Image and your Web browser are 
open and running on your computer.  
A button for each program appears in the taskbar at the edge of  
your screen.

 2. On the taskbar, click the button for your Web browser program.
 3. In your Web browser, locate the Web page that contains the picture  

you want. 
 4. Right-click the picture, and then click Copy. 
 5. On the taskbar, click the button for Microsoft Digital Image.
 6. On the Microsoft Digital Image File menu, click New.
 7. Select a canvas size, and then click Done. 

A blank canvas opens in the workspace.
 8. On the Microsoft Digital Image Edit menu, click Paste. 

The new picture appears on the canvas. 

Once the photo is opened in Microsoft Digital Image, you can edit it as you 
would any other photo and save it to your computer.

Watch for 
copyrights
Pictures you see 
on the Web may be 
copyrighted, so be 
sure to read the site’s 
legal information or get 
permission from the 
site’s owner before you 
use an image. 
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This chapter covers some of the fundamental aspects of Microsoft Digital 
Image that you’ll need to get started. You’ll find information on the Start-up 
Window, the work area, basic image manipulation, applying text, and Help 
resources.  

Start-up Window
The Start-up Window is a quick launching point to your pictures, Mini Lab, 
projects, the Library, recently opened files, and Help. 

By default, the Start-up Window opens every time you start Microsoft Digital 
Image. After closing the Start-up Window, you can open it at any time from the 
main work area by clicking the Start-up Window button in the Common Tasks 
list. This diagram points out the main features of the Start-up Window.

 1. Open Click this button to open the file browser, where you can open 
photos from your hard drive, a network drive, a digital photo card reader, 
a CD or DVD, or a floppy disk.

 2. Import Pictures Click this button to import one or more pictures from a 
digital camera, scanner, or other external storage device.  

 3. Microsoft Digital Image Library Click this button to open the Library, 
where you can find and organise your pictures.

 4. Edit Multiple Pictures Click this button to open the Mini Lab. The Mini 
Lab helps you perform routine editing tasks—such as rotating, resizing, 
or adjusting colours—on multiple pictures at the same time.  

 

Microsoft Digital Image Basics 
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 5. Create a Project Click this button to pick a project design. You’ll find 
a variety of projects—such as calendars, greeting cards, and album 
pages—designed to work with your photos. Projects are organised by 
type and by theme. 

 6. Show on start-up checkbox Select this check box to have the Start-up 
Window open every time you start Microsoft Digital Image. 

 7. Help links Click these links to go directly to resources that can help you 
get the most out of Microsoft Digital Image and digital imaging. 
• Take a Tour launches the product Tour. 
• Demonstration Videos displays links to the different videos available.
• How to… displays a collection of image-editing lessons.
• Online Photo Tips links you directly to the digital photography sec-

tion of the MSN Photos Web site.
• Register Online links you to the registration page of the Microsoft 

Web site.
 8. Recent Files See thumbnails of the last four pictures that you have edited. 

Click on one of the thumbnails to open that file.
 9. More Files Click this button to open the file browser, where you can 

open pictures from your hard drive, a network drive, a digital photo card 
reader, a CD or DVD, or a floppy disk. 

 10. Close Click this button to close the Start-up Window and go to the main 
work area.
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Examining the Work Area 
Most of the picture-editing tasks you perform in Microsoft Digital Image will 
be in the main work area. When you open Microsoft Digital Image and close 
the Start-up Window, you see the main work area. The picture below identifies 
the key elements of the Microsoft Digital Image work area.

 1. Menus 
Menus provide access to all of the Microsoft Digital Image features. 
The Help menu gives you access to the Help window, the Demonstration 
Videos, and the Microsoft Digital Image Tour.

 2. Toolbar 
The toolbar contains shortcut buttons for single-click access to some of 
the most common commands. To see the name of a toolbar button, hover 
the mouse pointer over the button.  

 3. Workspace Toolbar  
This toolbar contains buttons for the Common Tasks list, Stack, and Files 
palette. You can create more room in the workspace by hiding any of 
these tools.

 4. Common Tasks list 
The Common Tasks list is an easy way to locate features. This list 
provides convenient access to some of the most common tasks, as well 
as single-click access to the Mini Lab, project selector, and the Start-up 
Window. All of the features found in the Common Tasks list—as well as 
additional features—are also available in the menus.
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 5. Workspace 
The grey area represents the workspace, the area that the canvas sits 
within. You can use the zoom controls to magnify or reduce the canvas so 
that it covers more or less of the workspace.

 6. Selection Tools 
The selection tools allow you to isolate and work on a specific part of the 
picture.

 7. The canvas 
The white area is called the canvas, and it represents the printable area of 
the page. When you open a picture, the canvas is often not visible since it 
is covered entirely by the picture. You can use the zoom controls to mag-
nify or reduce the canvas so that it covers more or less of the workspace.

 8. Zoom controls 
The zoom controls magnify or reduce your photo so that you can see it in 
more or less detail.

 9. Stack 
The Stack displays a thumbnail of each object in your picture. You can 
rearrange the order of the objects by dragging thumbnails up or down 
within the Stack.

 10. Files palette 
The Files palette displays a thumbnail of all of the currently open 
pictures. You can switch your active picture by clicking a thumbnail in 
the Files palette. You can also add a picture to the one you’re working on 
by dragging the thumbnail from the Files palette to the canvas.
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Image Formatting
When you have a picture open on the canvas, there are a number of ways to 
re-size or re-orient it. 

Changing picture size
When you open an image onto the canvas, the on-screen representation of the 
image is automatically sized so that it fills the workspace. As a result, a high 
resolution image, such as 1600 x 1200 pixels, will appear onscreen just the 
same size as a low resolution image that’s only 640 x 480 pixels. For this rea-
son, viewing a picture on the canvas is not a reliable way of judging an image’s 
actual resolution.

Whenever you resize an image, consider these three factors: 

• Image size, which is the size of the printed image.
• Pixel dimensions, which is how many coloured dots (pixels) make 

up the picture.
• Resolution, which is the density of the pixels in the picture.

The image size is the product of the pixel dimensions multiplied by the resolu-
tion. For example, if you have a picture made of 1200 x 1800 pixels and print it 
at a resolution of 300 pixels per inch, it will print at a size of 4” x 6”. Given this 
relationship, if you change one of the three settings, one of the other settings 
will also have to change to keep the relationship equal. If you enlarged the 
picture in the previous example from 4” x 6” to 8” x 12”—and you kept the 
pixel dimensions the same—then the resolution would decrease from 300 pixels 
per inch to 150 pixels per inch.

When you resize a picture, it is generally not a good idea to try to increase or 
decrease the pixel dimensions since this reduces image quality. In most cases, 
it’s not necessary to adjust the image size, since that can be handled automati-
cally during printing. For high-quality prints, it’s generally good to keep the 
picture’s resolution at least 300 pixels per inch. But depending on you printer 
model and the image quality you desire, you may be satisfied with prints at 
only 150 pixels per inch. For Web use, 72 pixels per inch is usually considered 
sufficient. 
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To resize a picture:

 1. On the Format menu, click Resize Image.
 2. Click one of the following to lock the setting:

 • Image size
 • Pixel dimensions
 • Resolution 

 3. Enter amounts for the settings you want to change. 
 4. Click Done.
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Applying Text
You can add text to any picture and easily change the text font, font colour, font 
size, alignment, and emphasis. You start by adding a text box, and then you edit 
the text in the box. A text box is its own layer on the Stack.

To add text:

 1. On the Text menu, click Insert Text. 
A text box appears.

 2. Type your text. As you add text, the text box will automatically expand 
vertically to fit all of your text.

 3. To change the width of the text box, select the text box and drag one of 
the side resize handles.

 4. To move the text box, select it, hover the mouse pointer over the edge 
of the text box until the move handle appears, and then drag the move 
handle.

Once you’ve added the text, you can select the text to edit it. You can also select 
the text and use the toolbar buttons to change formatting. When text is selected, 
the following tools are available on the toolbar for formatting:

• The Font menu  lets you choose between 140 different 
fonts.

• The Font Size menu  lets you choose font sizes from 8 to 620 points.
• The Font Colour button  lets you choose from a standard palette of 

colours or choose a custom colour.
• The Bold button  adds bold formatting to the text.
• The Italic button  adds italic formatting to the text.
• The Underline button  underlines the text.
• The Alignment button  has menu choices for Left, Right, Centre, and 

Justify.
• The Bullets and Numbers button  lets you apply or cancel formatting 

for bulleted or numbered lists.



24 Chapter 4: Microsoft Digital Image Basics

Microsoft® Digital Image 2006 Standard Edition User’s Manual 

� � � � �

� � � �

Help Resources
There are multiple ways that you can learn more about using Microsoft Digital 
Image. In addition to this User’s Manual, there is the online Help system, the 
product Tour, and Demonstration Videos. The following sections describe the 
types of information available.

Online Help
Microsoft Digital Image online Help is the most comprehensive of the Help 
resources. It provides step-by-step instructions, overviews, troubleshooting top-
ics, technical support, and the “What’s wrong with this picture” diagnostic tool. 
Help includes several ways to find information, including a table of contents, a 
keyword index, and a full-text search of all Help topics.

This diagram identifies the main features of the Help window.

 1. The Show/Hide button Click this button to expand or collapse the left 
pane of the Help window.

 2. The Back button Click this button to go back to the last Help topic.
 

Accessing Help 
from the keyboard
You can access the 
online Help system at 
any time by pressing F1 
on the keyboard.
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 3. The Options menu This menu has options to print a topic or to set 
options such as Internet Options, where you can change the font size in 
the Help window.

 4. The Content Pane Displays the current Help topic.
 5. The Close button closes the Help window.
 6. The Contents tab displays the Help table of contents.
 7. The Index tab lets you find keywords in the index list.
 8. The Search tab finds topics that contain words that you enter.
 9. The Favourites tab lets you save topics for quick access later.

To access online Help:

 1. On the Help menu, click Microsoft Digital Image Help.

Using the table of contents
You can use the table of contents to locate information by subject. The table 
of contents is a useful way to see all of the features available in each category 
of features. 

To use the table of contents: 

 1. In the left pane of the Help window, click the Contents tab. 
 2. To expand a book in the contents, click the plus sign next to it. 
 3. To display a topic, in the contents list, click the topic title. 

Using the index
You can use the index when you are looking for information about a specific 
term or keyword. 

To use the index: 

 1. In the left pane of the Help window, click the Index tab. 
 2. In the Type in the keyword to find box, type the word you want to find. 
 3. In the results list, select the word you want to find, and then click Display. 
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Using the search
You can use the search function to find all the topics in Help that contain a word 
or combination of words. 

To use the search: 

 1. In the left pane of the Help window, click the Search tab. 
 2. In the Type in the keyword to find box, type the word for which you 

want to search, and then click List Topics. 
 3. In the Select topic to display list, select the topic you want to view, and 

then click Display. 

Product Tour
The Microsoft Digital Image Tour uses pictures, animations, and text to demon-
strate the most popular and useful features of the program.

To take the product tour:

 1. On the Help menu, click Take a Tour. 
The Tour opens, displaying icons to represent different categories 
of features.

 2. Click an icon. 
A feature list appears on the left side of the window. 

 3. Click a feature.  
Graphics and text appear that explain the feature.

 4. Repeat steps 2-4 to learn about more features.
 5. To close the Tour, click Close.



27Chapter 4: Microsoft Digital Image Basics

Microsoft® Digital Image 2006 Standard Edition User’s Manual 

Demonstration Videos 
Demonstration Videos use animation and narration to show you how to use a 
variety of image-editing features on your photos.

To watch a Demonstration Video:

 1. On the Help menu, click Demonstration Videos. 
The Help window opens to a topic about Demonstration Videos.

 2. Click a video title link. 
The Video player opens and the Video begins. 

The Demonstration Videos are accompanied by complete, online tutorials that 
let you walk through the tasks at your own pace. To open the online tutorial, 
click the Written Tutorial button on the Video player.

Technical Support 
The type of Technical Support resources available vary based on where you live 
and how you obtained your Microsoft Digital Image product. 

To view Technical Support information: 

 1.  On the Help menu, click About Microsoft Digital Image 2006 Standard 
Edition. 

 2. Click Tech Support. 
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Almost all pictures can be improved with basic touch-up tools. Microsoft Digi-
tal Image touch-up tools can be used to correct common problems such as red 
eye, crooked pictures, lighting problems, or similar distractions that can ruin a 
photo. In many cases, Microsoft Digital Image helps you eliminate basic prob-
lems with just a few clicks. 

Adjusting Brightness and Contrast
When you take a photo with an automatic camera, the camera’s automatic  expo-
sure feature measures the available light and determines how much light  is 
required to take the photo. Sometimes, the exposure meter’s measurement is 
slightly too low or too high, creating problems with brightness and contrast in the 
photo. Microsoft Digital Image provides tools to fix the levels of brightness and 
contrast.

To correct brightness and contrast:

 1. On the Touch-up menu, click Brightness and Contrast.
 2. Click Exposure auto fix.
 3. If you are not satisfied with the results, fine-tune the settings with the 

Brightness and Contrast sliders.
 4. Click Done.

The picture on the left is both too dark and too low contrast. The Exposure auto fix tool was 
applied to the version on the right, correcting both the brightness and contrast levels.

Basic Touch-up 

Making a copy to 
touch up
Never edit your only 
copy of a picture. 
Always make a copy or 
choose Save As to save 
the edited file with a 
different name. If you 
aren’t satisfied with the 
results, you can always 
start again from the 
original.
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Correcting a Colour Cast
When you take photographs, the source of the light can create a coloured cast in 
the photo. We tend to think of light being white, but nearly every light source 
has its own unique colour. For example, natural sunlight has a large component 
of blue in it, while incandescent (tungsten) lights—including most household 
light bulbs—give off a reddish or yellowish cast. 

When taking a photo, you can compensate for these different colours of light by 
setting the white balance (with a digital camera), or by using special filters (on a 
film camera). But if you still end up with a cast in your photos, use the Adjust 
Colour tool to correct the balance of colours to make the lighting look more 
natural. Using this tool, you locate a point that should be white, and then Micro-
soft Digital Image balances all of the colours in the picture based on the white 
point you set.

If you have already used the Levels auto fix tool, the tint problems in the picture 
may already be corrected. Use the Adjust Colour tool to make additional adjust-
ments to the tint.

To adjust colour:

 1. On the Touch-up menu, click Adjust Colour. 
The mouse pointer becomes an eyedropper.

 2. With the eyedropper, click an area in the picture that should be grey or 
neutral—in other words, not too colourful, too dark, or too light. 
Microsoft Digital Image automatically corrects the colours.

 3. If you are not satisfied with the results, use the Colour Balance sliders 
for fine-tuning.

 4. Click Done.

Setting the white 
balance on a 
digital camera
Many digital cameras 
allow you to set the 
white balance for 
specific types of light, 
such as sunlight, 
incandescent, and 
flash. Using this feature 
can help reduce tint 
problems in your 
pictures.

Zooming in to 
find white
If there are no significant 
areas of white in your 
photo, use the zoom 
controls to magnify the 
picture on the screen. 
When you zoom in, you 
might be able to use a 
very small area of white, 
such as the whites of a 
person’s eyes.
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Fixing Red Eye
Using your flash  in low-light situations can give your subjects red, unnatural-
looking eyes. The Fix Red Eye tool darkens the red spots in the eyes to reduce 
or eliminate the redness. 

To fix red eye:

 1. On the Touch-up menu, click Fix Red Eye.
 2. Use the pan and zoom controls to magnify your picture and focus on the 

red eyes in the photo.
 3. Click the red part of the eyes. You can click up to two eyes at once.
 4. Click Fix selected red eyes. 

The redness in the eyes is removed.
 5. Repeat steps 3 and 4 until the red is eliminated.
 6. Click Done.
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Straightening a Picture
If you took a photograph while unintentionally holding the camera at an angle, 
the horizon or other straight lines will appear tilted. This tilt can be a distrac-
tion in the picture, but is easily fixed with the Straighten Picture tool.

The Straighten Picture tool rotates the picture to make the horizon level.

To make the horizon level, the Straighten Picture tool rotates the picture on the 
canvas. When rotated, part of the picture overlaps the edge of the canvas, and 
these areas would be removed during printing. The rotation also creates empty 
areas at the corners of the canvas. Fortunately, these problems are solved by the 
Auto Crop feature which is part of the Straighten Picture tool. After you 
straighten the picture, Auto Crop trims the edges of the picture so that it 
becomes aligned with the canvas.  

To straighten a picture with Auto Crop:

 1. On the Format menu, point to Straighten Picture, and then click 
Canvas.

 2. Identify a line in the picture that should be straight (such as the horizon), 
and then click one end of the line.

 3. Click the other end of the line. 
The picture is automatically straightened.

 4. Make sure the Auto Crop check box is selected. 
The area of the picture that will be cropped is shown in lightened colour 
around the edges.

 5. Click Done.
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Cropping 
Cropping is an easy way to improve the composition of a photograph. For 
example, if your picture has distracting background elements along the top, 
bottom, or side, you can crop away these parts of the background to focus the 
attention on the subject. 

When you crop a photo, you are removing pixels, and therefore lowering the 
effective resolution (although the dots per inch will stay the same). If you crop 
a significant portion of the original, you’re limiting the extent to which you will 
be able to enlarge the picture for printing. This is why it’s better to compose the 
picture as best you can when you take it, rather than relying on heavy cropping 
later.

Cropping a picture allows you to eliminate distractions and improve the composition.

Cropping your picture to a specific proportion lets you control exactly where 
the picture will be cut. Otherwise, if your picture is not the same proportion as 
the print size, some of the picture might be trimmed during printing to fit into 
the printable area of the page. 
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Using the rule of thirds
When composing a photograph, many beginning photographers consistently 
centre their subject directly in the middle of the frame. While this technique 
may be the easiest way to get the subject in focus with a point-and-shoot cam-
era, it is not always the most interesting way to present the subject. 

Most advanced photographers follow the rule of thirds when composing the 
space inside a picture frame. The rule of thirds is used throughout the graphic 
design world, because it helps to create balance between the subject and the 
background. When you compose a picture according to the rule of thirds, you 
mentally divide the frame into thirds both horizontally and vertically (imagine 
a noughts and crosses grid), and place the point of interest on one of the four 
spots where the lines intersect. 

If the photo includes a person or animal, you can place the face on one of the 
four points, looking towards the centre of the scene. If the photo includes the 
horizon, it should run about one-third from the top or one-third from the bot-
tom, depending on whether the terrain or the sky is the centre of focus.

The cropped picture is a more interesting composition because it follows the rule of thirds.

To crop a photo using the rule of thirds: 

 1. On the Format menu, point to Crop, and then click Canvas.
 2. Under Select a proportion, click a proportion.
 3. Select the Show guidelines for the rule of thirds check box.
 4. Click a starting point on your photo, and then drag the outline to the 

opposite corner of the area to be cropped. 
The guidelines show the cropped area divided into thirds vertically 
and horizontally.

 5. Move and resize the cropped area so a focal point in the picture is 
positioned at one of the intersections of the guidelines.

 6. Click Done.
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After you have done general touch ups to your pictures, you may want to use 
advanced editing tools for more precise editing or to apply special effects. The 
selection tools and multiple-object composites give you the power to edit very 
specific areas of your pictures. You’ll also be able to transform your pictures 
with filters, colour and edge effects, and specialised editing brushes. 

Understanding Objects
For many advanced photo-editing tasks, you’ll need to understand the concept 
of objects. An object is a part of a picture that can be edited individually. For 
example, when you add text to a picture, the text is a separate object from 
the background image. When you edit the text—say, making the font colour 
red—the background picture remains unchanged because it is a separate object. 

Working with Composites
A picture that contains multiple objects is called a composite. The Stack helps 
you work with composites by displaying each object separately. Using the 
Stack, you can easily select any object. Make sure the Stack is showing in the 
workspace when you are working with composites.

To show the Stack:

 1. On the View menu, click Stack. 

On the Stack, you’ll see a thumbnail representation of each object in the 
composite. The top thumbnail represents the object that is the top layer in the 
composite. The bottom thumbnail represents the background object in the 
composite. Thus, the object that is lowest in the Stack may be at least partially 
obscured in the composite by the objects on top of it.

You can change the order of the objects in the composite by dragging 
thumbnails up and down the Stack. For example, dragging an object’s 
thumbnail from the lowest position on the Stack to the top position will bring it 
to the foreground of the composite.

Advanced Photo Editing 
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Locked Objects
When you open any single-object picture, such as a picture you have taken with 
your digital camera, the picture will, by default, be locked to its position on the 
canvas. When an object is locked to the canvas, the Lock icon  is shown next 
to that object’s thumbnail on the Stack. This Lock icon indicates that you will 
not be able to drag the object around on the canvas. 

To lock or unlock an object:

 1. Right-click the object’s thumbnail on the Stack.
 2. Click Lock or Unlock.
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Selecting Objects with the Object Tool
The Object tool  allows you to select one or more whole objects at a time. 
With the Object tool, you can move, resize, and rotate selected objects by 
dragging the object on the canvas or using the resize handles.  

Each time you start Microsoft Digital Image, the Object tool will be selected by 
default. You will be able to accomplish many different editing tasks by using 
the Object tool as your only selection tool. Unlike the other selection tools, the 
Object tool does not have an options palette.

To select an object with the Object tool:

 1. Make sure that the Stack appears in the workspace.
 2. Click the Object Tool button  on the toolbar.
 3. On the Stack, click the object.

When an object is selected with the Object tool and not locked to the canvas, 
object handles are displayed around the perimeter of the selection. Object 
handles are yellow circles that you drag to resize and rotate the object.

To move, resize, or rotate an object with the Object tool:

 1. Select the object with the Object tool as described above.
 2. If the selected thumbnail has the Lock icon  displayed, right-click the 

thumbnail, and then click Unlock.
 3. To move the selection, hold the cursor over the object until the move 

handle  appears, and then drag the object on the canvas.
 4. To resize the object proportionally, hold the cursor over one of the corner 

object handles until the resize handle  appears, and then drag the resize 
handle.

 5. To stretch the object, hold the cursor over the top, bottom, or side object 
handles until the resize handle appears, and then drag the resize handle.

 6. To rotate the object, drag the rotate handle  that is attached to the top of 
the selection box.

Selecting an object allows you to edit it without affecting other objects on the 
canvas. You can select an object by clicking it, either on the canvas or on the 
Stack. If you want to select a small object or one that is hidden behind other 
objects, it is often easiest to select it on the Stack. 
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Multiple Selection, Grouping, and Flattening 
Objects
Microsoft Digital Image allows you to create composites that contain many 
objects. While objects are separate, you can edit each one individually. 
However, sometimes you may want to edit two or more objects at the same 
time. There are three methods to join objects so that you can edit them together. 
From least permanent to most permanent, the three methods for combining 
objects are multiple selection, grouping, and flattening. 

Multiple Selection
Multiple selection links objects temporarily. For example, if you wanted to 
move three objects the same amount to the left, you could select the objects, and 
then drag them together on the canvas. Then, as soon as you select a different 
object to work on, the multiple-selected objects are no longer connected.

These three objects are a multiple selection, so they can be edited as a set and then 
separated later.

To select multiple objects:

 1. Make sure that the Stack is showing. 
 2. Pressing CTRL, click each thumbnail on the Stack until all of the objects 

are selected.
 3. To cancel the multiple selection, click any single object in the Stack.
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Grouping Objects
Grouping objects allows you to edit multiple objects and then maintain the 
grouped relationship while you do other tasks. The grouping relationship 
is even preserved when you close a picture file saved in PNG Plus format. 
Grouped objects can later be ungrouped and edited individually.

These three objects have been grouped, as indicated by the Group icon at the bottom of the 
selection box. 

To group objects:

 1. Make sure that the Stack appears in the workspace. 
 2. Pressing CTRL, click each thumbnail on the Stack until all of the objects 

are selected.
 3. On the Edit menu, click Group. 
 4. To cancel the group, click the group on the Stack, and then on the Edit 

menu, click Ungroup.
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Flattening Objects
Flattening objects is a permanent action. If you will no longer need to edit 
objects individually, you can flatten objects into a single object. This allows 
you to work on the objects together and reduce the number of objects in 
your composite. Also, many editing tasks cannot be performed on a multiple 
selection. But if you flatten the objects together, they become a single object, so 
you will be able to edit them together.

To flatten multiple objects:

 1. Make sure that the Stack appears in the workspace. 
 2. Pressing CTRL, click each thumbnail on the Stack.
 3. On the Edit menu, click Flatten Selected Objects.

Automatic Flattening
When working with objects that are multiple-selected or grouped, some editing 
tasks—such as using advanced selection tools—will automatically flatten the 
selected objects into a single object. Microsoft Digital Image will give you a 
warning message whenever two or more objects will need to be flattened to 
perform an editing function. When you see a warning message about flattening, 
you can click Cancel to prevent the objects from being flattened. 

Flattening Objects During Saving
When you save a composite picture in the PNG Plus file format, each object 
is preserved separately. When you open the file again, you can edit each 
individual object.

However, most file formats for images do not support multiple objects. So if you 
save a picture in the JPEG format, for example, all the objects will be flattened 
into a single object. Even if you open such a JPEG file in Microsoft Digital 
Image, you will not be able to edit objects individually.
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Using Selection Tools
Selection tools give you more control and more options for editing images. 
They allow you to fix problems that exist in only part of the picture. You can 
also use selection tools to create new objects that can be duplicated or pasted 
onto other pictures.

Selection tools help you to isolate any part of a larger picture, which enables 
you to:

• Turn part of a picture into a separate object.
• Apply filters or other effects to a limited area of a picture.
• Duplicate part of an image within a picture.
• Combine parts from two or more pictures.

The selection tools are located on the toolbar next to the Selection options 
button. There are five selection tools available, and each one works well for a 
specific editing scenario. Select the method that best fits your picture and your 
intended use. In addition to the Object tool mentioned above, the other four 
selection tools are:

• Marquee tool
• Freehand tool
• Edge Finder
• Magic Wand
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The Marquee Tool
The Marquee tool  helps you select part of an object in the shape of a 
rectangle, circle, or other shape. This tool is useful for cropping objects or 
pictures to a standard shape.

To make a selection with the Marquee tool:

 1. Make sure that the Stack appears in the workspace.
 2. On the Stack, click the object of which you want to make a partial 

selection.
 3. On the toolbar, click the Marquee Tool button .
 4. If the Marquee Tool options palette is not visible in the workspace, click 

the Selection button on the toolbar. 
 5. To keep the edges of the selection smooth, select the Anti-aliased check 

box on the Marquee Tool options palette.
 6. On the Marquee Tool options palette, click a shape for the marquee 

selection. 
 7. To keep the marquee shape in a specific proportion, click Shape 

proportions on the Marquee Tool options palette, and then enter a height 
and width.

 8. On the Marquee Tool options palette, choose whether you want to make 
a new selection , add to the current selection , or subtract from the 
current selection .

 9. Drag the marquee pointer diagonally across the area you want to select.
 10. To adjust the selection shape, click Adjust marquee on the Marquee 

Tool options palette, resize or rotate the marquee shape, and then click 
Done.

 11. To feather the selection (to make it blend into the surrounding part of the 
picture), click Feather on the Marquee Tool options palette, enter the 
number of pixels that you want feathered around the edge, and then click 
OK.

 12. To select the opposite area, click Invert on the Marquee Tool options 
palette.

Anti-aliasing a 
selection
Anti-aliasing means 
that pixels on the edge 
of the selection can 
be partially selected. 
This technique helps to 
smooth the transition 
between the selection 
and the surrounding 
area. Anti-aliasing is 
useful when creating 
composites.

Feathering a 
selection
Like anti-aliasing, 
feathering a selection 
helps to smooth its 
edges. But where anti-
aliasing only affects 
pixels directly on the 
selection border, you 
can feather a border 
of up to 250 pixels 
around the edge of the 
selected area. 
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The Freehand Tool
The Freehand tool  helps you select part of an object by drawing an 
irregular shape. 

 1. Make sure that the Stack appears in the workspace.
 2. On the Stack, click the object of which you want to make a partial 

selection.
 3. Click the Freehand Tool button  on the toolbar.
 4. If the Freehand Tool options palette is not showing, click the Selection 

button on the toolbar. 
 5. To keep the edges of the selection smooth, select the Anti-aliased check 

box on the Freehand Tool options palette.
 6. On the Freehand Tool options palette, click whether you want to make 

a new selection , add to the current selection , or subtract from the 
current selection .

 7. On the picture, drag the pointer, and then click the starting point to 
complete the selection. 

 8. To feather the selection (to make it blend into the surrounding part of the 
picture), click Feather on the Freehand Tool options palette, enter the 
number of pixels that you want feathered around the edge, and then 
click OK.

 9. To select the opposite area, click Invert on the Freehand Tool options 
palette.
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The Edge Finder
The Edge Finder  helps you select part of an object by tracing along well-
defined edges. This tool is useful for cutting out or copying people or detailed 
items in a picture. 

 1. Make sure that the Stack appears in the workspace.
 2. On the Stack, click the object of which you want to make a partial 

selection.
 3. Click the Edge Finder button  on the toolbar.
 4. If the Edge Finder options palette is not showing, click the Selection 

button on the toolbar. 
 5. To keep the edges of the selection smooth, select the Anti-aliased check 

box on the Edge Finder options palette.
 6. On the Edge Finder options palette, click whether you want to make a 

new selection , add to the current selection , or subtract from the 
current selection .

 7. On the Edge Finder options palette, enter a value in the Width box. The 
Width is the number of pixels away from the pointer that the Edge Finder 
will try to detect an edge. 

 8. On the picture, click points along the edge of the item you want to select. 
As you trace, make sure that the edge stays within the zone of the Edge 
Finder.

 9. To close the selection area, click the starting point.
 10. To modify the selection, click Adjust edges, drag any point in the 

selection marked by a square, and then click Done.
 11. To feather the selection (to make it blend into the surrounding part of 

the picture), click Feather on the Edge Finder options palette, enter 
the number of pixels that you want feathered around the edge, and then 
click OK.

 12. To select the opposite area, click Invert on the Edge Finder options 
palette.
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The Magic Wand
The Magic Wand  lets you select parts of an object that are the same or 
similar colours. The Magic Wand is useful for selecting a consistently coloured 
area—a blue sky for example—without having to trace around it. 

 1. Make sure that the Stack appears in the workspace.
 2. On the Stack, click the object of which you want to make a partial 

selection.
 3. Click the Magic Wand button  on the toolbar.
 4. If the Magic Wand options palette is not showing, click the Selection 

button on the toolbar. 
 5. To select only similarly coloured pixels that are connected to each other, 

select the Contiguous check box. Also, selecting the Smooth Edges 
check box reduces the jaggedness of your selection.

 6. On the Magic Wand options palette, enter a value in the Tolerance 
box. The Tolerance is the range of colours that will be included in the 
selection.

 7. On the Magic Wand options palette, click whether you want to make a 
new selection , add to the current selection , or subtract from the 
current selection .

 8. On the picture, click the colour you want to select. 
 9. If the selection includes too much or too little of the area you want to 

select, enter a different value in the Tolerance box, and then make 
another selection.

 10. To feather the selection (to make it blend into the surrounding part of 
the picture), click Feather on the Magic Wand options palette, enter the 
number of pixels that you want feathered around the edge, and then click 
OK.

 11. To select the opposite area, click Invert on the Magic Wand options 
palette.
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Editing and Copying Selected Areas
Using the advanced selection tools helps you to isolate a very specific area of 
a picture for editing or copying. For example, if a picture has generally good 
lighting levels, but a person’s face in a picture is in dark shadows, you can make 
a selection of just the face, and then adjust the brightness and contrast only in 
the selected area. And with anti-aliasing and feathering the selection, your edits 
to the selected area can look natural since the edited area will blend smoothly 
with the surrounding pixels. 

Copying, Cutting, and Pasting Selections
Advanced selection tools also allow you to cut out or copy part of an object 
to create a new object. These techniques allow you to trim a hole in a picture 
or create a new object that can be pasted in the same picture or in a different 
picture. 

To cut a hole in an object:

 1. Make sure that the Stack appears in the workspace.
 2. On the Stack, click the object you want to cut a hole in.
 3. On the toolbar, click a selection tool, and then select part of the object.
 4. On the Edit menu, click Cut.

To copy and paste part of an object:

 1. Make sure that the Stack appears in the workspace.
 2. On the Stack, click the object you want to copy part of.
 3. On the toolbar, click a selection tool, and then select part of the object.
 4. On the Edit menu, click Copy. 

The selection is copied to the clipboard.
 5. If you want to paste the selection onto a different picture, open that 

picture so that it is on the canvas.
 6. On the Edit menu, click Paste. 

The selection becomes a new object on the Stack.

Note: If you paste the selection onto the same picture that you copied it from, 
the new object will be in the same position and may not look like a separate 
object. But the new object will be visible on the Stack, and you can use the 
object tool to move, resize, or rotate the new object.
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Filters
The term filter originates from the coloured glass covers placed over a camera 
lens. The first filters in digital imaging sought to mimic the results of these 
physical camera filters, providing a slight shift in colour, or increasing the 
intensity of colours. But the filters in Microsoft Digital Image can create many 
other effects, from sharpening an image to making the picture look like a 
painting or a mosaic.

Three different filters were used on the original picture (upper left): The Coloured Pencil filter 
(upper right), the Watercolour filter (lower left), and the Film Grain filter (lower right). 

To apply a filter:

 1. On the Effects menu, point to Filters, and then click a filter.

Filters create a whole new look for your pictures. Many filters make the image 
look less like a photograph and more like a drawing, painting, mosaic, or other 
hand-created artwork. Filter-enhanced pictures can become an attractive focal 
point of projects such as greeting cards and calendars. 

Waiting for filters 
to be applied
Some filters require 
your computer to make 
many calculations, so 
on a slower computer 
they may take a few 
minutes to be applied.
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Colour Effects 
You can give a  picture a new look by applying a colour effect. Turn a favourite 
colour picture into an instant classic by changing it to black and white. 
Or, apply the antique effect, which “ages” your picture by giving it an old 
newspaper look. You can even turn it into a photographic negative.

To turn a colour picture to black and white, antique, or negative:

 1. On the Effects menu, click one of the following:
• Antique
• Black and White

 • Negative
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Paint Effects 
With the Freehand Paint Brush, you can choose from several painting tools: 

• Paint brush
• Airbrush
• Pencil
• Eraser
• Highlighter 
• Chalk

Use these tools to add new colours to a picture.

To use the Freehand Paint Brush:

 1. On the Effects menu, point to Paint Brush, and then click Freehand.
 2. Click a painting tool, and then click a colour.
 3. Click a brush size, and then paint by dragging on the picture.
 4. Click Done.

You can paint with stamps to enliven your pictures with a rubber stamp effect. 
Choose from a variety of stamp designs or make your own. Paint with a single 
stamp design, or use multiple stamps on the same picture.

You can choose from a wide variety of stamps to customise any picture.
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To paint with stamps:

 1. On the Effects menu, point to Paint Brush, and then click Stamps.
 2. Click a stamping style, and then click a stamp.
 3. Click a stamp size, and then apply the stamp by clicking on the picture.
 4. Click Done.



517

Microsoft® Digital Image 2006 Standard Edition User’s Manual 

If you take pictures regularly, it can become time consuming to perform basic 
editing to all of your pictures after you download them from your camera. Mini 
Lab contains tools that can help you save time with routine editing that needs to 
be done to many or all of the photos in a batch.

If you have a high-capacity storage medium in your camera, you might have 
dozens, or even hundreds, of photos to download at once to your hard disk. 
Some of these pictures may be excellent “keepers” that you will want to spend 
some time editing carefully later on. But many of the photos only need a few 
quick edits: changes such as rotation and resizing. 

Opening each photo individually, performing basic edits, and then saving each 
one could take a lot of time. Mini Lab lets you perform these routine editing 
tasks to many photos at once. Mini Lab lets you select multiple photos to 
perform numerous tasks, including:

• Colour auto fix
• Exposure auto fix
• Camera phone auto fix
• Rotate 
• Resize
• Print
• Save as (to save copies of the originals, change file format, 

and rename files)

Batch Editing in Mini Lab 
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Mini Lab displays all of your open photos, and includes a list of editing options 
that you can perform on multiple pictures. This diagram identifies the main 
features of Mini Lab.

 1. The Open more files button opens the file browser to let you find more 
pictures to edit.

 2. The editing options list shows all of the tasks available for batch editing.
 3. File options let you save or print multiple photos.
 4. The Workspace in Mini Lab contains thumbnails of all of your opened 

pictures.
 5. The Done button closes Mini Lab, keeping the photos open and maintain-

ing the changes you have made.
 6. The Cancel button closes Mini Lab, undoing any unsaved changes.
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To open Mini Lab from Microsoft Digital Image:

 1. On the Touch-up menu, click Batch Edit in Mini Lab.

To open Mini Lab from the Library:

 1. In the Thumbnail pane, select the pictures you want to edit.
 2. On the Tasks menu, click Batch Edit.

When the Mini Lab starts, it automatically displays all pictures that were open 
in the program. Select the pictures you want to edit, and then click one or more 
editing tasks. The changes are applied automatically, but they are not saved 
unless you choose Save As in the Mini Lab or save your pictures in Microsoft 
Digital Image after exiting the Mini Lab.
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When you’ve finished editing a photo, you can add polishing touches by 
surrounding it with an edge, a border, a mat, or a frame. 

Edge Effects
Edge effects alter the outside edge of a photo. For portrait photos, try the soft 
edge effect. To draw attention to photos that you post on a Web site, try apply-
ing one of the highlighted edges.

The photo on the left has highlighted edges applied, which work great for photos on the Web 
and in e-mail. The photo on the right has been enhanced with soft edges.

To add an edge effect:

 1. On the Stack, click the layer to which you want to add the edge effect.
 2. On the Effects menu, point to Edges, and then click an edge effect or 

border.
 3. If available, click a specific edge or border.
 4. Follow the instructions on the screen to customise the size or colour of 

the edge or border.
 5. Click Done.

Adding Edges, Mats, and Frames 

Shrinking a picture 
to show the edge 
effect
Some edge effects 
appear only behind and 
outside the picture. So if 
your picture reaches the 
edge of the canvas, you 
might not be able to see 
the edge effect when 
you print it or save it to 
the Web. 

To make sure you can 
see an edge you’ve 
added, make sure the 
object is not locked to 
the canvas, and then 
the press the CTRL key 
while you drag in one of 
the photo’s corner resize 
handles. This will shrink 
the photo proportionally 
on the canvas, so that 
the border lies within the 
printable area.
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Mats and Frames
If you plan to put a photo in a traditional photo frame, you can add a Microsoft 
Digital Image mat to your photo before you print it. Mats create an elegant 
effect, and can also help to fit an oddly-proportioned print to a standard-size 
frame. 

If you don’t plan to mount a photo in a traditional frame, but would like to print 
and display it, use a Microsoft Digital Image frame instead. You can choose 
from a variety of frame themes to complement the subject of your photo. You 
can even add both a mat and a frame to the same photo.

Microsoft Digital Image has a wide variety of mats and frames to finish your favourite photos.

To add a mat or a frame:

 1. Select the picture or object to which you want to add a mat or frame.
 2. On the Effects menu, point to Edges, and then click Frames and Mats.
 3. Click a theme, click a design, and then click Open.
 4. Drag your photo from the Files palette into the frame or mat, and then 

click Next.
 5. Move or resize the photo so that it fits within the frame, and then 

click Done.

Choosing the 
right mat
When choosing a mat, 
consider the colours 
in your photo and the 
colours of your frame. 
A mat should not 
overpower the subject of 
the photo. Try selecting 
a soft-coloured mat 
that matches one of 
the photo’s secondary 
colours. 



579

Microsoft® Digital Image 2006 Standard Edition User’s Manual 

A great way to present your pictures and share them with friends and family is 
to create photo projects. Microsoft Digital Image offers a range of designs that 
you can use to showcase your pictures. Choose from greeting cards, calendars, 
business cards, and more.

Creating Photo Cards
Use your own photo to personalise a greeting card for a holiday, a party invita-
tion, or any other occasion. 

To open a photo card design:

 1. Open a photo and check to see that it appears on the Files palette.
 2. On the File menu, click Create a Project.
 3. On the All Types of Designs page, click Cards.
 4. Click Photo Frame Cards.
 5. Click a theme, click a design, and then click Open.
 6. Follow the instructions on the screen. 
 7. To edit the inside pages, on the View menu, click Front of Card, Inside 

of Card, or Back of Card.  

Once your card project is open, you can add your own text, photos, and clip art. 
Since most printers cannot print to the edge of the page, the purple margins on 
the edges of a card project represent the unprintable areas of the card.

Photo cards are either half-fold cards, which are larger cards printed on both 
sides of the paper, or quarter-fold cards, which are smaller cards printed on only 
one side of the paper. 

Creating Projects 

Working with a 
multi-page project
When working with a 
project that has more 
than one page (such 
as a greeting card), 
the multi-page palette 
appears on the bottom 
of the screen. This 
palette lets you switch 
between pages in the 
project. 



58 Chapter 9: Creating Projects

Microsoft® Digital Image 2006 Standard Edition User’s Manual 

A favourite golfing photo was used to create this half-fold card.

To change the fold style of a card:

 1. On the Format menu, click Change Card Fold.
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Creating Calendars
Calendars are a great way to showcase your favourite photos. Calendar projects 
are available in the following formats: 

A one-week calendar                                            A one-year calendar

A one-year calendar                                      

These are the first three months of a 12-month calendar
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To create a calendar project:

 1. On the File menu, click Create a Project.
 2. Click Calendars.
 3. Click a calendar type.
 4. Click a theme, click a design, and then click Open.
 5. Set the start date for the calendar, and then click Next.
 6. Follow the instructions on the screen to add a photo to your calendar, and 

then click Next.
 7. Move or resize your photo on the calendar. Use the corner resize handles 

to resize the photo proportionally.
 8. Click Done.

When you create a 12-month calendar, you can add different photos to each of 
the 12 month pages.

To complete a 12-month calendar:

 1. Complete the instructions above to create a 12-month calendar.
 2. Open the photos you want so that they appear in the Files palette.
 3. Use the multi-page palette to switch between pages in the project. 
 4. Drag photos from the Files palette into each of the 12 month pages. 
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Saving Pictures
If you’re like most people, you can’t bear to throw photos away, even if they’re 
imperfect. You probably have a large box or two filled with envelopes of old 
negatives and photographic prints. Keeping track of all of your old prints and 
negatives can be a formidable task. 

Fortunately, digital photography makes saving, storing, and organising photos 
much easier. However, there are some important things you should know about 
saving your photos to make sure they’ll be in good condition whenever you 
want to enjoy them.  

Saving Multiple Versions
Once you’ve imported a photo from your camera to your computer and erased 
it from your camera, your computer’s hard disk contains the only copy of that 
photo. This original version should be treated like a film negative: You don’t 
want to do anything to it that will alter the original content. Except rotation 
to correct orientation or renaming the file, the original version should be left 
alone.

When you want to edit a photo or add it to a project, you should always save 
a copy of the original and work with the copy. That way, if you make some 
editing changes that you regret later, you can always go back to the original, 
make a new copy, and start over.

To make a copy of a picture:

 1. Open the picture.
 2. On the File menu, click Save As. 

The Save As dialog box opens.
 3. Click the folder where you want to save the copy of the original. 
 4. In the File name box, enter a name for the copy.
 5. Click Save. 

The Save As dialog box closes, with the new copy of the picture open in 
the workspace. 

Saving and Printing Pictures 
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Choosing a File Format
Microsoft Digital Image allows you to save photos in a number of image file 
formats. You can determine the best format for saving your photos based on 
what you will use the photos for, compatibility with other computers, and file 
size. To help you understand the difference between file formats, here are some 
important characteristics of three common image formats:

• Microsoft Digital Image PNG Plus (.png) saves the individual objects 
in your photo projects so you can edit them later. PNG offers lossless 
compression, but not all computers have the software to open PNG files.

• TIFF (.tif) is a common format for cameras that produce lossless images. 
TIFF does not support layers, but is a good format for saving important 
photos, although the files are relatively large and take up a lot of space. 

• JPEG (.jpg) is the most common format for images, since the files can 
be opened on practically any computer. JPEG does not support layers. 
Too much JPEG compression can reduce image quality, but JPEG is a 
format that makes relatively small files that work well for most purposes, 
especially for e-mail and the Web. 

To save a photo in a specific file format:

 1. On the File menu, click Save As. 
The Save As dialog box opens.

 2. In the Save as type box, click a file type.
 3. Click Save.
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Setting PNG Plus Options
Only Microsoft Digital Image can read individual objects saved in PNG Plus 
files. However, a PNG Plus file contains a flattened PNG version of the picture 
that can be read by many other programs, including Internet Explorer. By 
default, Microsoft Digital Image saves the flattened version of the picture at the 
same size as the original, multi-object picture. But while this flattened version 
of the picture allows the file to be opened by other programs, it does increase 
overall file size. 

If you don’t need to have a full-size, flattened version of the picture embedded 
in each PNG Plus file, you can choose to save the flattened version of the 
picture at a smaller size. Limiting the dimensions of the embedded file can 
decrease the overall file size.  

To limit the size of the embedded, flattened PNG file:

 1. On the Tools menu, click Options.
 2. Click PNG Plus options.
 3. Click No Larger Than, and then enter values to limit the width and 

height. 
 4. Click OK, and then click OK.
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Saving for E-mail and the Web
Unlike photos for printing, photos for e-mail and the Web work best if they are 
relatively low resolution. Low-resolution photos, such as one that is 440 x 330 
pixels, move faster through dial-up modems, and they are the right dimensions 
for viewing on most computer monitors.  

To save a photo for e-mail or the Web:

 1. On the File menu, point to Save a Copy For, and then click Save for 
E-mail or Web. 

 2. Do one of the following:
• Click a picture size
• Set maximum dimensions

 3. Click Save As. 
The Save As dialog box opens.

 4. Click the folder to which you want to save the photo.
 5. In the File name box, type a file name, and then click Save.

Avoid sending large 
photos in e-mail
Sending high-resolution 
photos in e-mail may 
cause problems for your 
recipients. For example, 
a single 5-megabyte 
(MB), high-resolution 
image will take over 20 
minutes to download on 
a 28.8-Kbps modem. 
Also, some e-mail 
programs limit the size 
of attachments, and 
may, for example, block 
e-mail with attachments 
larger than 1 MB.
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Printing Pictures

Printing Single Pictures
Microsoft Digital Image has a simple process for printing single images. When 
using the single-picture printing task, one copy of the picture will print on the 
page, and the picture will be centred on the paper. 

To print a single picture:

 1. Make sure your printer is turned on and connected to your computer.
 2. On the File menu, click Print.
 3. Under Select a printer, click the printer you want to use.
 4. To specify printer settings, click Change printer settings.
 5. Select the number of copies, and then select a print size.
 6. Click an orientation, and then click Print.

Installing printer 
drivers
When adding a new 
printer, make sure that 
you install all the printer 
software and drivers. 
If you’re installing an 
older printer, you may 
be able to find updated 
printer drivers on the 
manufacturer’s Web 
site.
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Printing Multiple Pictures
Microsoft Digital Image has a wide variety of templates that allow you to print 
multiple pictures on a page. You can print multiple copies of the same picture or 
multiple pictures together at the same time. 

Printing on a multi-photo sheet saves paper and is a convenient way to create 
prints to give to family and friends.

To print multiple photos on the same page:

 1. Make sure your printer is turned on and connected to your computer.
 2. Open all the pictures that you want to print so that they are on the Files 

palette.
 3. On the File menu, click Print.
 4. Under You can also, click Print multiple pictures or on special paper.
 5. Under Select a printer, click a printer.
 6. To specify printer settings, click Change printer settings.
 7. Select a category of page layout, and then click an orientation.
 8. Click a layout in the right pane, and then click Next.
 9. Drag pictures from the Files palette onto the layout.
 10. Click an option for fitting the selected picture to the area, and then 

click Next.
 11. Preview the page layout, and then enter the number of copies you want 

to print.
 12. Click Print.

Printing from the 
Library
Microsoft Digital 
Image Library uses the 
same printing tools as 
Microsoft Digital Image. 
To start the print task, 
use the Thumbnail pane 
to select the picture or 
pictures that you want to 
print. Then, on the File 
menu, click Print.
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Selecting Print Quality
Most desktop printers are capable of printing in a range of qualities, from a 
low-quality draft mode to a high-quality setting that requires more time and 
uses more ink. Printer settings for quality and colour vary, but you may be 
able to specify your paper type, ink type, dots per inch required, and colour 
management preferences. Some printers have simplified printing options such 
as “Good,” “Better,” and “Best.” Make sure to read your printer’s manual to 
find out how to take advantage of these different settings.

To select print quality for your printer:

 1. On the File menu, click Print.
 2. Click Change printer settings. 

Your printer’s dialog box opens. 
 3. Adjust your printer’s quality settings, and then click OK.

Selecting a Print Size
The quality of photo prints is directly related to the number of pixels in the 
picture. A high-resolution picture contains a lot of detailed visual information, 
and can be printed at larger sizes. For example, a picture whose dimensions 
are 2048 x 1536 pixels (3.1-megapixels) would look good even when printed as 
large as 8” x 10” on most printers. 

A low-resolution picture has less detailed visual information, and therefore 
cannot be printed in larger sizes. A picture with pixel dimensions of 1280 x 
960, for example, lacks the detail needed to fill an 8” x 10” print. The result 
would be a grainy, pixelated image. But printing this picture at a smaller size, 
such as 4” x 6”, would give you a sharp, detailed print.

As a general rule, try to print around 200 dots per inch (dpi). Take your 
picture’s pixel dimensions and divide by 200 to see how large the print can be 
in inches.

Turning on colour 
management
Check your printer’s 
manual to see if 
it offers colour 
management. Colour 
management can help 
your printer to produce 
colours that match the 
ones on your monitor. 
If your printer offers 
colour management, 
click Change picture 
settings while 
performing the Print 
task. Your printer’s 
dialog box will open, 
and you can adjust 
the settings for colour 
management.
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Choosing Photo Paper
If you want your images to look like traditional photographs, choose paper that 
is clearly labelled as photo paper. Photo paper comes in a range of thickness 
and texture. Paper weight ranges from ordinary office-document weight to a 
fairly heavy watercolour paper. If you choose a heavyweight paper, check your 
printer’s manual to make sure that your printer can handle it. 

The quality of the image will be affected by the kind of paper stock you choose. 
As a rule, you’ll see the widest range of colours and get the deepest blacks 
from paper that has been specially coated to accept inkjet inks. The range of 
colours appears to be widest on the whitest papers. Glossy surfaces also create 
the illusion of deeper blacks. However, if you’re going to display your prints, 
glossy surfaces can cheapen the look of the work, and surface glare can make 
the images more difficult to view.

Paper formulations also contribute greatly to resisting fading and colour 
shifting. If you’re using “fade-resistant” or “archival” inks, look for coated, 
acid-free papers that are also advertised as fade-resistant or archival.

Creating Long-lasting Prints
When buying supplies for your printer, check which types of ink and paper are 
recommended by the manufacturer of your printer, and find out about the ink’s 
lifespan rating. Some six-colour printers use inks specially formulated for long 
life. When printed on high-quality heavyweight matt paper, photos from these 
printers can last approximately 40 years before perceptible fading occurs.

Fade ratings are given as the amount of time before any colour shift in the 
print can be seen by the naked eye. The actual time it would take for the 
print to become unacceptably discoloured would be several times that. These 
ratings are based on indoor exhibition under glass in an atmosphere that is 
not chemically polluted. Ozone is especially harmful to dye-based printing 
inks. Do not display these prints in rooms where oxygen tanks or electric air 
fresheners are used—both produce high amounts of ozone. 
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Ordering Prints
Order prints of your photos online and have the prints sent to you or your 
family and friends. You can also use your photos to create a variety of photo 
gifts.

To order prints and enlargements:

 1. On the File menu in Microsoft Digital Image, click Order Professional 
Prints. 

 2. Your Web browser should display a photo printing page. On the Web, 
click Order Prints. 

 3. Follow the directions on this Web site to place your order for photo 
prints. The pictures will be uploaded to the photo printing site, processed, 
printed, and mailed to your home.
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Microsoft Digital Image Library is a powerful tool that helps you organise, 
find, and view your pictures and short videos. Microsoft Digital Image Library 
does not store or make a copy of your pictures and videos. Instead, it stores 
information about your pictures and videos, including a thumbnail version of 
each picture, so you can conveniently organise and find them on your computer. 

Microsoft Digital Image Library automatically tracks information about each 
picture and video you add to the library, including the date the picture was 
taken, file size, image size, and the folder where the picture is stored. You can 
add labels, such as ratings, keywords, and captions, to pictures and videos. 
Tools like the Label Painter and the Preview pane make it easy to add labels to 
an entire collection of pictures at one time. 

Using the information that you provide about each picture, Microsoft Digital 
Image Library helps you locate your pictures and videos by using powerful 
filtering and grouping. Even if you have many pictures taken over several years, 
you can locate pictures that share the same keywords, dates, ratings, and more. 

Microsoft Digital Image Library also allows you to make simple changes 
to multiple pictures at the same time, such as batch editing in the Mini Lab, 
renaming, converting file formats, and resizing.

Opening Microsoft Digital Image Library
The Microsoft Digital Image Library can be opened from the Windows Start 
menu or from the Microsoft Digital Image Start-up Window or File menu. 

Organising and Viewing Pictures  
in Microsoft Digital Image Library 

Microsoft Digital 
Image Library is 
just a catalogue
Remember that 
Microsoft Digital Image 
does not copy your 
pictures elsewhere on 
your computer; it simply 
creates a catalogue 
of your pictures. Don’t 
delete the original 
pictures in the My 
Pictures folder (or 
elsewhere), thinking 
that your pictures are 
stored in Microsoft 
Digital Image. If you 
delete a picture from 
its original location on 
your computer, it will be 
deleted from Microsoft 
Digital Image Library 
as well.
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Adding Pictures and Videos to 
Microsoft Digital Image Library
Any pictures and videos  you have in your My Pictures and My Videos 
folders—and their subfolders—are automatically added to Microsoft Digital 
Image Library’s database. You can also add pictures and videos from other 
folders on your computer. 

The first time that you open Microsoft Digital Image Library, the Welcome to 
Microsoft Digital Image Library window will open to help you add pictures 
and videos from folders other than the My Pictures and My Videos folders. 
After the first use of the Library, you use the same process to add additional 
pictures to Microsoft Digital Image Library.

To add pictures and videos from a folder on your computer:

 1. On Microsoft Digital Image Library’s File menu, click Add Pictures and 
Videos 
to Library. 
The Add Pictures and Videos to Library window opens. The folders 
already catalogued in Microsoft Digital Image Library are displayed.

 2. Click Browse. 
 3. Navigate to the folder containing the items you want to add, click the 

folder, and then click OK.
 4. Click Done.

Adding Pictures 
from CDs or other 
removable media
You can use Microsoft 
Digital Image Library 
to catalogue pictures 
located on CDs or other 
removable media. To 
import these photos 
into the Library, click 
the Import button on 
the toolbar to launch 
the Import Pictures 
Wizard.
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Scanning for Pictures and Videos
Microsoft Digital Image Library can scan your computer’s hard disk drive to 
locate items to add to Microsoft Digital Image Library. This feature is helpful 
if you have pictures and videos stored in multiple locations or if you don’t 
remember where your pictures are stored. The scanning process can take some 
time if there are many picture files on your computer.

To scan for pictures and videos on your computer:

 1. On Microsoft Digital Image Library’s File menu, click Add Pictures and 
Videos to Library. 
The Add Pictures and Videos to Library window opens. The folders 
already catalogued in Microsoft Digital Image Library are displayed.

 2. Click Scan. 
 3. In the Beginning Picture Scan dialog box, click OK. 

The hard disk drive is scanned, and the folders containing pictures 
are displayed.

 4. Clear the check box next to any folder you don’t want to add.   
 5. Click OK, and then click Done. 

Use Microsoft 
Digital Image 
Library for your 
videos, too
If your digital camera 
can capture videos 
in addition to still 
pictures, you can 
import, store, organise, 
and view those videos 
right along with your 
pictures. To view a 
video, double-click its 
thumbnail and it will 
play in the Library.
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Adding Labels
Adding labels to your pictures is one of the most powerful ways to organise 
and locate your pictures. Labels are bits of information that you apply to 
your pictures—information that helps to identify the pictures. Labels do not 
change the appearance of your pictures in any way; they are simply tiny bits 
of information that get stored in the Library and associated with each picture. 
There are a number of labels available in the Library, including the following:

• People. Create People labels for friends and family, then click that 
person’s label to find all the pictures of that person.

• Places. Label your pictures with Places that help you instantly find 
photos you took last year in Tunisia or five years ago in Spain.

• Events. Use these labels to identify pictures by activities or occasions, 
such as birthday parties or holidays.

• Keywords. You can turn any word or phrase into a keyword, making 
it easy to label pictures any way you like. You’re not limited to the 
people, places, events, or keywords that come with Microsoft Digital 
Image, since you can add your own.

• Ratings. With a click, you can rate your pictures on a scale of one to 
five. This can make it easy to find your best pictures.

• Flags. These little icons help you mark certain pictures for special 
reasons. You can add the To Print flag to pictures you want to print for 
a holiday greeting card, for instance.
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Don’t forget that you can create your own labels to identify the subjects of your 
pictures, and you can add multiple labels to each picture, or add the same label 
to multiple pictures. 

In addition, labels can have hierarchy (sometimes referred to as parent or child 
labels). Imagine that you want to create labels to represent the members of your 
family. You might want to create a subcategory in People called Family and 
then add one label for each family member to that group.

Your labels can have sublabels. You can use this feature to help you  
organise your labels into logical groups. 

The Label Painter is a fast way to add multiple labels to pictures in Microsoft 
Digital Image Library. 

Applying labels with the Label Painter

 1. On the Tools menu, click Label Painter.
 2. If desired, add a new label by right clicking where you want it to appear 

and clicking Create label. To create a label that is not a child of another 
label, right click on the category (People, Places, Events, or Keywords) 
that you want to place it in. 

 3. Click the label or labels you want apply to pictures. The label’s checkbox 
is filled to show that it is ready to be painted onto pictures and videos.

 4. Click the pictures you want to assign those labels to.
 5. To close the Label Painter, click the close button on the Label Painter 

title bar.
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Finding Your Pictures
Once you have added your pictures to Microsoft Digital Image Library and 
added some labels to your pictures, you can use the Library to quickly locate 
pictures or browse your photo collection by any criteria you choose.

The left pane of Microsoft Digital Image Library is called the View By pane. 
The View By pane allows you to filter the pictures displayed in the Thumbnail 
pane. 

If you are viewing by date or by folder, you can click the All Pictures and 
Videos View at the top of the View By pane, so that all of your pictures appear 
in the Thumbnail pane.

Viewing by Label
Viewing by labels is the most powerful way to use Microsoft Digital Image and 
it might be the way you prefer to find and organise your pictures.

Use the View By pane to quickly find pictures with certain labels. 

To view by label:

 1. On the View By menu, click Label.
 3. Click the labels that represent the pictures you are trying to find. 

Pictures with those labels appear in the Thumbnail pane.
 4. To deselect a label, click the label to clear its check box.
 5. To find pictures with no labels assigned, click the Unassigned.
 6. To view all pictures regardless of labels, click Folder on the View By 

menu, and then click All Pictures View.
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Viewing by Folder
Viewing by folder allows you to find your pictures based on where the pictures 
are stored on your computer. Remember, Microsoft Digital Image Library 
does not actually store pictures, it just remembers where they are located. 
When viewing by folder, the folders shown mimic the folder structure on your 
computer. When you click a folder or drive in the View By pane, only pictures 
in that folder (and its subfolders) are displayed in the Thumbnail pane.

To filter by folder:

 1. On the View By menu, click Folder. 
 2. In the folder structure, click a folder or drive. 

Pictures in that folder are displayed in the Thumbnail pane.
 3. To view pictures from all folders and removable media, click All 

Pictures View.

Viewing by Date
Viewing by date allows you to filter your pictures based on the dates the 
pictures were taken. You can set the filter to display pictures taken in a 
particular year, month, or even a single day. When you click a year, month, 
or date in the View By pane, only pictures taken during that timeframe are 
displayed in the main viewing area.

To filter by date:

 1. On the View By menu, click Date. 
 2. Click a year to display the months within that year. 
 3. To display the days in a month, click a month.
 4. To display the pictures from a particular day, click the day. 
 5. To view pictures from all dates, click All Pictures View.
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Using the Thumbnail Slider
The thumbnail slider, in the upper right of the Thumbnail pane, allows you to 
change the size of the thumbnails. With larger thumbnails, you must scroll more 
to see all your pictures, but more detail is visible. With smaller thumbnails, you 
can see more pictures at once.

You can adjust the size of the thumbnails in the Thumbnail Pane, but don’t forget 
that you can see a large thumbnail just by holding the mouse pointer over a picture. 

To use the thumbnail slider:

 1. To increase the size of the thumbnails, do one of the following:
• Drag the slider to the right.
• Click the plus (+) button.

 2. To decrease the size of the thumbnails, do one of the following: 
• Drag the slider to the left.

 • Click the minus (-) button.
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Showing Thumbnail Data
There are three ways to view the thumbnails and their associated data in the 
Thumbnail pane.

Tiles View
Along with the thumbnail, the tiles view displays:

• Caption
• Time and date taken
• File size
• Image size (pixel dimensions)
• File name
• Rating

Thumbnails View
The thumbnails view displays only the thumbnail with no data.

Thumbnails with Text View
The Thumbnails with text view displays the thumbnail and the field that the 
pictures are arranged by.

To switch views in the Thumbnail pane:

 1. On the View menu, click one of the following:
• Tiles
• Thumbnails

 • Thumbnails with text



80 Chapter 11: Organising and Viewing Pictures in Microsoft Digital Image Library

Microsoft® Digital Image 2006 Standard Edition User’s Manual 

Grouping Your Pictures
You can group the pictures in the Thumbnail pane according to date, ratings, 
labels, or other information.

Grouping by rating, for example, will separate all the one-star pictures into one 
group, the two-star pictures into another group, and so on. 

To group your pictures: 

 1. On the Group By menu above the Thumbnail pane, click a grouping 
option.

Showing the Table of Contents
You can open the table of contents, which is hidden by default, to list all of the 
groups currently in the Thumbnail pane. The table of contents is located along 
the left of the Thumbnail pane. To see the pictures of a particular set, just click 
the group in the table of contents.

To show the table of contents:

 1. On the View menu, click Table of Contents.
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Using the Preview Pane
The Preview pane, located under the Thumbnail pane, is a convenient way 
to view and edit information about a picture or pictures. The Preview pane 
displays the information about the pictures selected in the Thumbnail pane. You 
can click any of the fields (except file size and image size) in the Preview pane 
to edit the information. 

To use the Preview pane:

 1. In the Thumbnail pane, select the picture you want to preview. To select 
multiple pictures, press CTRL while you click the thumbnails.

 2. Click one of the following fields:
• File name will change the file name for all selected pictures. If more 

than one picture is selected, the file names will be the base name that 
you enter, followed by a sequential number.

• Caption will apply the caption that you enter to all selected pictures, 
replacing any previously associated captions. 

• Date taken will change the date taken field for all selected pictures, 
which is useful if your camera recorded incorrect dates. If the selected 
pictures have more than one date taken, this field will appear as Date 
Range.

• Labels opens the Labels Editor to add new labels to the selected 
pictures; existing labels will not be deleted.

• Flags displays convenient labels that you can use as personal 
reminders to edit, e-mail, print, or perform other actions on indicated 
pictures.

 • Rating assigns a new rating to each selected picture, replacing any  
 pre-existing rating.

Showing the 
Preview pane
The Preview pane can 
be hidden from view to 
make more room in the 
Thumbnail pane. If the 
Preview pane is hidden, 
you can show it again by 
checking Preview Pane 
on the View menu.  
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Editing and File Management from 
Microsoft Digital Image Library
With its powerful organisational tools, Microsoft Digital Image Library is 
an easy way to locate pictures in your collection. Once you have found the 
pictures you want to work with, you can select those pictures for editing and file 
management. 

Editing Pictures
From Microsoft Digital Image Library, you can open pictures in a picture 
editing program, perform your editing tasks, and then return to Microsoft 
Digital Image Library.

To edit pictures:

 1. In the Thumbnail pane, select the pictures you want to edit.
 2. On the Tasks menu, click Edit. 

The pictures open in the picture editing program.
 3. Edit and save the pictures.
 4. Close the picture editor. 

Thumbnails in Microsoft Digital Image Library will be updated to show 
your changes.

By default, Microsoft Digital Image Library will open the pictures to be edited 
in Microsoft Digital Image. But you can set Microsoft Digital Image Library to 
open a different photo editor.

To change the photo editor associated with Microsoft Digital Image 
Library:

 1. On the Tools menu, click Options.  
 2. Click the General tab.
 3. Under Change picture editor, do one of the following:

• Click Use Microsoft Digital Image 2006.
 • Click Use a different picture editor, and then locate 

 the picture editing program you want to use.
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Editing in Mini Lab
Mini Lab allows you to perform the most common editing tasks to multiple 
pictures at the same time. Some of these tasks include: 

• Colour auto fix
• Contrast auto fix
• Rotate
• Crop 

The Mini Lab you can access from Microsoft Digital Image Library is the same 
Mini Lab you can access from Microsoft Digital Image.

To batch edit pictures in Mini Lab:

 1. In the Thumbnail pane, select the pictures you want to edit.
 2. On the Tasks menu, click Batch Edit in Mini Lab. 

Mini Lab opens with the selected pictures.
 3. For each batch-editing task, select the pictures you want to edit, and then 

click an editing option. 
 4. Click a file saving option. You must save the files for the Mini Lab 

changes to be saved.
 5. Click Done. 

Mini Lab closes and thumbnails in Microsoft Digital Image Library will 
be updated to show your changes.

Batch File Management
Microsoft Digital Image Library has its own tools for batch file management. 
These tools include batch rename, batch convert file format, and batch resize. 
These file management options save you time when you need to perform the 
same task on multiple files.

To begin batch file management:

 1. In the Thumbnail pane, select the pictures you want to manage.
 2. On the File menu, click one of the following:

• Batch Rename
• Batch Convert File Format

 • Batch Resize
 3. Follow the instructions on the screen.
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No matter how polished and creative you are as a photographer, Microsoft 
Digital Image is a valuable tool for helping you get the most out of your 
pictures. With Microsoft Digital Image features, you can easily correct 
common photo problems such as red eye and overexposure. And you can use 
features like filters and layers to create photos strikingly different from your 
originals.

Although Microsoft Digital Image is a powerful photo-editing program, it’s 
important to get the best photo you can at the time you take it. Microsoft Digital 
Image can do a lot to correct minor problems with the originals, but certain 
problems, such as severely blurred or underexposed photos, cannot easily be 
fixed with computer software. And if you can develop your photography skills 
to take higher-quality photos, you can spend your time doing creative photo 
editing with Microsoft Digital Image, rather than fixing avoidable mistakes.

Many cameras available today offer a high degree of automation: just turn 
the camera on and press the shutter, and the camera does the rest. While this 
approach is quick and easy, it isn’t perfect in all situations. As a photographer, 
you can learn to fine-tune the settings on your camera to gain greater control of 
the camera and get the best possible photo for each situation. 

Because of the range of cameras available—from basic point-and-shoot 
models to professional SLR (single-lens reflex) cameras—this chapter cannot 
cover specifics for all features available on all cameras. But it will provide a 
foundation of photography concepts that are vital to taking consistently good 
photographs.

The first section of this chapter contains information specific to digital cameras: 
concepts such as resolution and compression that don’t have direct counterparts 
in film photography. Later sections cover universal photography concepts that 
apply to both film and digital cameras.

Taking Great Pictures 

Opening photos 
from your digital 
camera
For information about 
opening pictures 
from your camera in 
Microsoft Digital Image, 
see the digital camera 
section in the “Opening 
and Importing Pictures” 
chapter.
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About Digital Cameras
If you’re new to using digital cameras, several camera features might seem 
foreign to you. Some of these features, such as digital zoom and compression, 
do not exist with film camera. But it’s important to understand what these 
features do and when it’s appropriate to use them.

Photo Quality
A digital photograph is composed of tiny coloured squares called pixels (short 
for picture elements). Like a mosaic, the pixels blend together to form a picture. 
Each digital picture consists of a set number of pixels, ranging from a few 
thousand to millions. When a digital camera takes a photo, it creates a digital 
file that includes some number of pixels, each with a precise colour.

Pixels are not a set size, so they can shrink or enlarge depending on the size at 
which the picture is printed or displayed. When a photo is enlarged too much, 
the individual pixels become visible, making a jagged looking, poor-quality 
photo. 

The original photo on the left was saved at high resolution, and you can see sharp detail. The 
photo on the right has been saved at such low resolution that you can see the individual pixels.

The number of pixels that make up a picture is the resolution. Resolution and 
compression are key factors in determining the quality of a digital photo. The 
following sections explain resolution and compression.  
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Resolution

Resolution is one of the main factors that determine picture quality, since it is 
a measure of the total number of pixels that make up a photograph. Resolution 
is sometimes expressed as the total number of pixels, such as 3 megapixels 
(3 million pixels), or in pixel dimensions, such as 1600 by 1200 pixels (which 
equals 1,920,000 total pixels, or 1.9 megapixels). 

Resolution is important primarily because it determines how much you can 
enlarge a picture. Everything else being equal, a 3-megapixel picture and a 320 
pixel x 240 pixel picture look the same in a wallet-size print. But if you enlarge 
those two pictures to 5” x 7” prints, the quality of the 320 x 240 picture is very 
low: you can see the individual pixels. The 3-megapixel picture still looks sharp 
at the larger size, since its pixels are still too small to be seen.

Resolution is also important because it determines file size. High-resolution 
pictures contain colour information for many more pixels than low-resolution 
pictures, so the files for high-resolution pictures can be significantly larger. File 
size becomes an issue if you have limited storage on your camera or hard disk, 
or if you need to send the picture through e-mail.

The following chart gives an estimate of file size and maximum print size 
for various resolutions. The chart lists file sizes for JPEG format, which is a 
common (but not the only) format for pictures. This is just a general guide to 
file sizes—you might produce good printing results by using larger or smaller 
files.
  Approx. JPEG file size  
Dimensions Total pixels (with slight compression*) Maximum print size

320 x 240 76,800 23 KB Web and e-mail

640 x 480 307,200 91 KB Web and e-mail

1280 x 960 1,228,800 363 KB 4” x 6” 
 (1.2 megapixels) 

1600 x 1200 1,920,000 576 KB 5” x 7” 
 (1.9 megapixels) 

2,048 x 1,536 3,145,728 970 KB 8” x 10”  
 (3.1 megapixels) 

3008 x 2000 6,016,000 1.5 MB 11” x 14” 
 (6 megapixels) 

* Compression, which is explained in the following section, varies by camera, so you might 
find different file size results.
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Instead of film, a digital camera uses an image sensor—usually a CCD 
(charge-coupled device) or CMOS (complementary metal oxide semiconductor) 
chip—to capture the visual information when you take a picture. The image 
sensor on a simple, low-resolution camera might capture just over 76,000 pixels. 
The image sensor on a high-quality digital camera might capture more than 
6 megapixels. As you can imagine, the 6-megapixel camera can produce very 
large, high-quality pictures (with very large files). The 76,000-pixel camera can 
capture a relatively small number of pixels, so photo quality would be fair to 
poor, even at small print sizes.

On many cameras, you can set the resolution at which the image sensor 
captures the picture. As a general rule, always use the highest resolution 
possible—you’ll get higher-resolution pictures that you can print in larger sizes. 
However, in some cases you might want to lower the resolution so that the files 
will be smaller. This allows you to store more photos on the camera’s storage 
media, but you must sacrifice some quality for quantity.

Make sure to check your camera’s manual to find out what resolution you will 
get from the photo-quality settings on your camera. Beware of settings that 
offer “enhanced” or “interpolated” resolution. These features add extra pixels 
not found in the original photo to product a higher-resolution picture, but might 
reduce overall sharpness or quality.

Megapixel rating
One of the main factors 
in the price of a digital 
camera is its megapixel 
rating. The megapixel 
rating indicates the 
maximum number of 
pixels (in millions) that 
are captured by the 
camera’s image sensor.
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Compression

You’ve seen one way to reduce picture file size: lower the picture resolution. 
You can also reduce file size by having the camera compress the picture 
file as it saves the file to the camera’s memory. Compression consolidates 
similar information in the picture, and discards some information. With JPEG 
compression, for example, series of similarly coloured pixels are grouped 
together and considered to be the same colour. In the code that makes up the 
file, the colour information for these grouped pixels only has to be listed once 
instead of hundreds, or even thousands, of times. This shortcut can reduce file 
size considerably. Taken to extremes, a picture in highly compressed JPEG 
format might be 95 percent smaller than the same photo in an uncompressed 
format.  

Although compression does reduce file size, it also reduces visual quality. 
Slight to moderate compression might not noticeably reduce picture quality, 
but high compression produces visible areas of blotchy colour called artefacts. 
Even with slight compression, artefacts become more pronounced each time the 
photo is resaved and compression is applied.

The left photo has been saved with lossless compression, so all of the image quality is 
retained. The photo on the right was saved with heavy JPEG compression—which is not 
lossless—and the compression significantly reduced the image quality.

For important pictures that you want to print, it’s good practice to use little 
or no compression. Or, if your camera offers it, you can take your photos in a 
format, such as TIFF, that offers lossless compression. Lossless compression 
reduces file size, but retains all of the photo quality once the photo is restored.    

File size and 
picture quality
Lowering resolution and 
increasing compression 
both reduce file size 
and picture quality. 
Bearing this in mind, 
you can use file size 
as a rough way to 
judge the overall 
visual quality.
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File Formats
There are many file formats designed for digital pictures. Microsoft Digital 
Image can work with JPEG, TIFF, and many other file formats. If your camera 
allows you to choose file formats for your pictures, you can decide which 
format to use based on your particular criteria: photo quality, file size, or 
compatibility with other programs.

The JPEG format is the most common format for photos. JPEG files are 
versatile, since they can accommodate over 16 million colours, can be 
compressed, and can be viewed on almost any computer and in any Web 
browser. To reduce file size, the JPEG format always uses compression, 
although the degree of compression varies by camera. Experiment with the 
compression settings on your camera to find a low-compression setting that 
produces good or excellent results. Because JPEG uses some compression every 
time a file is saved, many photo purists prefer formats like TIFF over JPEG. 

The TIFF format provides an extremely accurate recording of digital-image 
data. Some cameras can use a lossless compression method with TIFF. But even 
with some compression, TIFF files are much larger than JPEG files for pictures 
with the same resolution. For example, a single uncompressed 5-megapixel 
TIFF image is larger than 10 MB. To work with pictures of that size, you need a 
lot of memory on your computer and a high-volume storage disk.   
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Using Zoom Features
A zoom lets you adjust the focal length of the lens, making your subject appear 
closer to or farther from the camera. Some cameras have built-in adjustable 
zoom lenses; others accommodate interchangeable zoom lenses of different 
focal lengths.

Digital cameras might offer optical zoom or digital zoom. An optical zoom 
feature uses the same principle as a zoom lens on a film camera: the lens itself 
moves to change the focal length. In any of the zoom positions, the resulting 
resolution is the same.

A digital zoom feature does not move the lens. Instead, the software inside the 
camera crops the photo to make the subject appear closer. Because the pixels 
are removed from the area that’s cropped out, the overall resolution is lower. 
Many cameras offer a combination of optical and digital zoom. For best results, 
use only optical zoom. Then, if necessary, use Microsoft Digital Image to crop 
the photo to enlarge part of the scene.

Both “digital zoom” and “enhanced resolution” features use interpolation 
to add pixels to the original photo, a process that increases the overall size 
or resolution. Interpolation assigns colours to the added pixels based on the 
colours of the surrounding pixels. While these features technically do increase 
the pixel count in a picture, they do not achieve the same visual quality as 
a picture that has not been interpolated. If your camera has digital zoom or 
enhanced resolution, test it and make sure you like the results before you use it 
for important pictures. For true zoom capability and highest image quality, use 
optical zoom.

Expand your 
perspective
Zoom lenses are great 
for capturing objects 
you can’t get close to, 
such as a ship sailing 
in water far from the 
shore. Use a zoom lens 
to get close-up, candid 
shots of people without 
seeming intrusive or 
conspicuous.
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Memory Cards, Disks, and Sticks
After the image sensor captures a picture in your digital camera, the digital 
information is stored on removable media, such as a CompactFlash, xD Card, 
Secure Digital card, Memory Stick, SmartMedia, Microdrive, floppy disk, or 
CD-R.

While you can still find digital cameras that store pictures on CD-R or floppy 
disk, such models are almost entirely overshadowed by cameras that use 
removable memory cards. Compared to removable memory, floppy disks and 
CDs are slow, bulky, and limited in capacity.  

Memory cards are small, durable, and have almost unlimited reusability. And 
while higher capacity cards are always priced higher than lower capacity cards, 
storage technology advancements invariably lower price barriers. 

Buying additional storage media, like these CompactFlash cards, 
allows you to take many more photos in a single session.

The size of your storage media dictates how many picture you can store. The 
media that is included with some cameras can only hold a few high-resolution 
pictures. This type of low-capacity card can be impractical for situations such 
as travelling. To give yourself more flexibility, you might want to purchase 
additional removable storage media.
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Battery Life
Compared to film cameras, many digital cameras use batteries at a surprising 
rate. The LCD preview screen and the flash on the camera both put a heavy 
drain on the batteries. And unlike some manual film cameras, digital cameras 
cannot function without batteries or an AC power adapter.

To maximise the amount of time you can use your digital camera before 
the batteries fail, you can buy rechargeable batteries, which last longer than 
disposable alkaline batteries. Keep your spares charged so they’ll be ready 
when you need them. If you are running low on power and don’t have a spare 
battery, conserve remaining power by trying the following:

• Turn off your LCD screen and compose through the viewfinder.
• Turn off your flash so that it doesn’t fire automatically. Turn the flash on 

only when you need it.
• Wait until you’re home to preview your photos.

The best 
rechargeable 
batteries
Lithium-ion batteries 
and nickel metal 
hydride (NiMH) 
batteries both work 
very well with cameras, 
providing excellent 
power and convenience. 
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Using the Flash
Learning to use the flash is one of the easiest ways to get better pictures 
both indoors and outdoors. Especially when you’re photographing people, 
overpowering light from the flash can ruin the shot, often in ways that are 
difficult to correct with picture-editing software.

Most cameras come equipped with a built-in flash. The flash might be 
programmed to go off automatically when the camera senses that the flash  
is needed. But relying on the camera’s judgment will not always give you the 
best results. Built-in flashes can create harsh shadows, overexposed areas, and 
unnatural-looking light.

Read your camera’s manual to learn what the recommended flash range is, and 
to find out how to adjust different flash settings. Three of the most common 
flash settings are outlined in the following sections.

Automatic Flash
Contrary to what you might think, you might be better off without your flash 
in many situations. If you think the scene is too dark to take without a flash, 
try increasing the ambient light by turning on lamps or opening the drapes. 
On most digital cameras, you can increase the ISO equivalent setting, in effect 
making the image sensor more sensitive to the available light, which allows you 
to take pictures in low light without a flash.

Many newer cameras offer low-light modes and night-flash settings that 
improve the quality of low-light photos. If your camera offers these options,  
use them. Otherwise, always stay within the recommended range of the flash.

Upgrading 
your flash
If your camera supports 
an external flash, 
consider buying one, 
especially if you take 
a lot of indoor photos 
of people. An external 
flash will give you much 
more control and often 
better results.

The range of 
your flash
Check your camera’s 
manual to find out the 
recommended range 
for your flash. Most 
on-camera flashes are 
designed to illuminate a 
subject that is 10 to 15 
feet from the camera. 
If the flash is too close, 
your subject might look 
too bright or washed 
out in the photo. If 
you’re too far away, 
the flash won’t provide 
enough light.
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Red-Eye Reduction Flash
One of the most common problems with flash photos of people and pets is red 
eye. This problem is caused by a flash located very close to the camera lens. 
The light from the flash reflects off the blood vessels in the subject’s retina, 
causing the pupils to look red. This problem occurs frequently in low-light 
situations, when pupils are likely to be dilated. There are several things you can 
do to help avoid red eyes in your photos:

• Increase the ambient light in the room. Turning on lights and opening up 
the drapes reduces the size of your subjects’ pupils.

• Use your camera’s red-eye reduction setting. This feature fires preflash 
bursts that help reduce the dilation of the pupils before the exposure.

• If you have an off-camera flash, move it away from the camera lens. 
Then, even if your subjects’ pupils are dilated, the light comes from a 
different angle and reduces or eliminates the red-eye effect.

Fixing red eye with 
Microsoft Digital 
Image
If you end up with red 
eyes in your pictures, 
Microsoft Digital Image 
makes it very easy to 
remedy this problem. 
For more information, 
see the section about 
removing red eye in this 
book’s “Basic Touch-up” 
chapter.
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Fill Flash
You can use the fill flash setting to fill in deep shadow areas caused by bright 
overhead light or in a scene where the light is behind the subject. 

In the left photo, the strong backlighting creates a shadow that covers the subject’s whole 
face. For the photo on the right, fill flash was used to counteract the backlighting and keep the 
shadows off the subject’s face.

If your flash is using the automatic setting, bright daylight can prevent it from 
firing. Turn on the flash manually, or, if your camera has a fill-flash setting, turn 
it on. If you see shadows on your subjects’ faces as you’re composing the shot, 
fill flash is a good idea.

An alternative to using the fill flash is moving to a different place where 
the light from the sun is diffuse and indirect, which produces a softer, more 
flattering portrait light.
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Using Your Camera’s Manual Settings
In today’s camera marketplace, the lines between manual and automatic 
cameras have become blurred. It used to be that manual cameras were 35mm 
SLR (single-lens reflex) cameras with manual controls for focusing, aperture, 
shutter speed, and film speed. On the other end of the spectrum were fully 
automatic cameras with very limited controls, possibly only a shutter button. 

For serious camera users, the manual SLR cameras were usually the best 
option, since they offered so much control. The creative process was not left 
to the automatic settings of a camera. Automatic point-and-shoot cameras 
were good for novice photographers who didn’t want to worry about setting 
the camera controls. Many automatic cameras could produce adequate or 
even excellent photos without requiring knowledge of advanced photography 
concepts. 

While you can still find fully automatic and fully manual cameras, many of 
today’s cameras offer different modes for different degrees of automatic and 
manual control. For example, some SLR film cameras let you switch to an 
automatic mode where the camera determines everything from focusing to 
setting the aperture. Many compact digital cameras are designed to be used 
primarily in automatic mode, but also allow you to switch to program and 
manual modes to control exposure settings, like shutter speed and aperture. 

With digital cameras, the adjustments that you make are often digital 
approximations of the equivalent function in film cameras, as with shutter 
speed or ISO. But the photographic result is the same. The following sections 
provide an overview of the most important manual camera settings and 
concepts. 

Exposure
Exposure describes the amount of light that comes into your camera when you 
take a picture. Setting the camera to the correct exposure is crucial to getting 
the proper tones and colours in your pictures. Overexposure occurs when too 
much light has reached the image sensor (or film in a film camera), which 
decreases detail and causes the photo to look washed out. Underexposure 
occurs when insufficient light has been let into the camera, and the picture 
looks dim and murky.

Exposure is controlled by three factors: the aperture, the shutter speed, and the 
ISO rating. Aperture is the size of the opening that lets light into the camera. 
Shutter speed is how long light is allowed into the camera. ISO rating (the film 
speed in a film camera) is the sensor or film’s sensitivity to light.
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The water glass analogy

When taking a  picture, your goal is to achieve a perfect exposure. To create 
the right exposure, you need to understand the relationship between the three 
exposure factors: aperture, shutter speed, and ISO rating. Achieving perfect 
exposure can be compared to filling a glass completely without spilling any 
of the water. For a perfect exposure, the glass should become completely full 
with no water spilling over. In this analogy, the tap symbolises the aperture: 
the wider the tap is open, the faster the glass fills up. The time that the tap is 
open represents the shutter speed: leaving it open longer lets more water into 
the glass. To fill the glass to exactly the right level, the rate of flow must be set 
according to the time the tap is open. 

The third factor, ISO rating, can be equated to the size of the water glass. A 
smaller glass, representing a faster ISO rating, fills up more quickly than a 
larger glass, representing a slow ISO.

Understanding automatic exposure

As a photographer, you will come across a wide range of lighting conditions, 
and each condition requires that you adjust your camera to different exposure 
settings. For example, taking a photo on a beach on a sunny day calls for 
different exposure settings you would use on the same beach on a cloudy day.

For many conditions, the camera’s automatic exposure setting gives you good 
or even excellent results. But for some situations, the automatic exposure does 
not perform as well.

Automatic exposure assumes that the scene you are photographing has a few 
bright spots, many midtones, and a few dark areas. As the camera’s meter reads 
the available light in your scene, it averages the light in the bright, middle, and 
dark areas, and then calculates the exposure necessary to bring the average 
level to a tone of medium brightness called middle grey. 

Automatic exposure does not work well if your scene is dominated by large 
sections of very light or very dark colours. A bright field of snow, for example, 
has so much bright light that the automatic exposure lowers the brightness until 
the snow looks grey. To work around this shortcoming, you can use exposure 
compensation.
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Exposure Compensation
Some cameras have an exposure compensation feature that lets you manually 
override the automatic exposure setting. Exposure compensation lets you adjust 
the exposure with settings such as +2, +1, -1, and -2. A +1 setting, for example, 
tells the camera’s automatic exposure system to make the middle tones brighter. 
When taking a picture dominated by bright snow, increasing the exposure with 
the +1 setting might correct the light level for the snow-filled scene. Your actual 
results will vary according to your camera and the brightness of the day. 

With bright snow in a scene, setting your camera’s exposure compensation 
setting to +1 or +2 might help you to get the right exposure.

Increasing your 
chances with 
bracketing 
If you’re not sure 
what the best 
exposure setting is, try 
bracketing. Bracketing 
involves taking multiple 
photos of the same 
scene. Start by using 
the automatic exposure, 
and then use exposure 
compensation to take 
additional frames 
with increased and 
decreased exposure 
levels. With a series 
of photos taken at 
different settings, 
there is a good chance 
that one has perfect 
exposure.
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Aperture
The aperture is the opening through which light passes to reach the film, or, in 
digital cameras, the image sensor. Aperture is measured by f-number, where 
a specific setting is called an f-stop. With f-stops, a low number, such as f/4, 
represents a wider opening that lets in more light. A small aperture, such as 
f/16, lets in significantly less light. 

Some cameras have a fixed aperture that can’t be adjusted. If you’re adjusting 
the aperture yourself, a setting of f/8 is a good place to start, since it gives you a 
fairly wide zone of sharpness.

If your camera allows you to adjust the aperture, use the settings to regulate the 
depth of field in your picture. Depth of field refers to the zone in your photo that 
is in acceptably sharp focus. A wide aperture gives you a shallow depth of field, 
while a small aperture allows a very deep zone—maybe even everything in the 
picture—to be in focus. 

Imagine pointing your camera down a railway line which goes all the way to 
the horizon. With a wide aperture, like f/2.8, if you focus on a sleeper a short 
distance away, only a few of the other sleepers are in sharp focus. With a 
narrow aperture, like f/22, many more of the sleepers are in focus, even those 
quite a distance from your main focal point.

A wide aperture will give you a short depth of field, as illustrated in the photo on the left, 
where only the eagle is in focus. The photo on the right was taken with a small aperture, 
so almost everything is in focus.

Program modes
If your camera offers 
program modes for 
specific types of 
pictures like portraits 
or action shots, read 
your camera’s manual 
to find out the aperture 
settings used for those 
modes. 
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For portrait photography, a wide aperture helps to limit the focus. Your 
subject’s face is clear and sharp, but objects in the background are blurred. But 
if you’re taking a holiday photo of someone posing in front of a monument, a 
narrow aperture might be in order. With the narrow aperture, both the person 
and the monument can be in focus in the same photo. 

Of course, adjusting the aperture also affects how much light is let into the 
camera. But if a specific depth of field is important for your shot, you might 
want to switch to manual mode, set the aperture, and then set the shutter speed 
to get the correct exposure level. Some cameras also offer an aperture priority 
mode that automatically selects the correct shutter speed to produce the correct 
exposure for the aperture you select.
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Shutter Speed 
In most cameras, the shutter is the curtain in front of the film or image sensor 
that is retracted for a precise amount of time to let light into the camera. Shutter 
speed can be adjusted to let light into the camera for a longer or shorter amount 
of time. 

When determining the correct exposure for a picture, both shutter speed and 
aperture must be considered in relation to each other. An increase in shutter 
speed, which lessens the time the film is exposed to light, requires that you 
widen the aperture to let in more light.

Shutter speeds are measured in fractions of seconds. In automatic mode, 
many cameras will use a shutter speed of about 1/125th of a second. For action 
photography, a very fast shutter speed, like 1/500th of a second, can help to stop 
action and reduce blurring caused by movement of your subject. 

The shutter speed determines whether you freeze the action or show motion blur.

On the other extreme, you might set the shutter to stay open for four seconds, 
or even more for low-light night photography without a flash. But shutter speeds 
slower than 1/30th of a second increase the likelihood that slight movements in 
your hand while you take the shot will cause a blurred photo. To avoid camera 
shake, mount your camera on a tripod or other firm surface for slow shutter 
speeds.  
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To accommodate the low light of this twilight scene, the camera 
was mounted on a tripod and set to a slow shutter speed.

Some cameras offer a shutter priority mode that sets the aperture automatically 
after you set the shutter speed. This can be useful if you’re in a situation where 
shutter speed is more important than aperture, like when you’re photographing 
a subject in motion.  
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ISO Setting or Equivalent
When taking pictures on film, you have the opportunity to select different types 
of film for specific uses. Films are available in different speeds that are more 
sensitive or less sensitive to light. 

The film speed is measured by ISO number. A high-speed film, such as ISO 
800, is ideal for low-light situations or action photography, since the film 
requires less light to properly expose the photo. Slow-speed films, such as 
ISO 100 or ISO 200, are good for photographing in bright daylight, since they 
require a lot of light. If you plan on using the same roll of film for multiple 
settings and light levels, ISO 400 film is a good compromise and does relatively 
well in most situations.

Faster films generally produce grainier pictures than lower-speed films. Some 
of the newer varieties of professional grade high-speed films produce a finer 
grain structure, which is less noticeable. 

Since digital cameras use an image sensor instead of film, there is no way to 
actually change the film speed. However, many digital cameras provide the 
digital equivalent of an ISO. Sometimes called the sensitivity setting, this 
feature, in effect, allows you to change the ISO setting. For example, if you are 
in a low-light situation, you can switch from ISO 100 to ISO 400.

With most digital cameras, setting the digital equivalent of the ISO setting to a 
faster speed can introduce noise into the picture. Similar to the graininess from 
high-ISO film, noise is pixels of random colour that mar the picture. Cameras 
vary widely, so you should experiment with your digital camera’s ISO settings 
and examine the results. 

In low-light situations, consider turning off the flash and setting the camera 
to a faster ISO setting. This might produce some noise in the picture. But that 
result might be preferable to what you’d get by taking the photo at a slower ISO 
setting with the harsh lighting of the on-camera flash.

ASA versus ISO
If you have an older 
camera, the film speed 
dial might be labelled 
ASA instead of ISO. 
These film speed 
ratings are the same, 
and the ratings are 
interchangeable. 

Avoid sharpening 
pictures that have 
noise
Do not use the sharpen 
feature in Microsoft 
Digital Image on digital 
photos with noticeable 
noise; sharpening 
accentuates the 
inaccurate pixels.
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Setting the White Balance
Surprisingly, digital cameras do not automatically know what colours are your 
picture. Instead, your camera must figure out which colour in a scene is white, 
and use that information to colour the rest of the picture. This is called setting 
the white balance. To calculate the white balance, the camera assumes the 
lightest spot in the picture is white, and adjusts the other colours accordingly. 
Under most circumstances, this automatic function should prevent an off-colour 
cast in your photos. 

However, in some lighting conditions, the camera fails to correctly set the white 
balance. If you’re taking pictures indoors, for example, incandescent lights 
give off a yellowish or reddish glow. This colour is not really visible to the 
naked eye, but often shows up in indoor pictures. To counteract this problem, 
most digital cameras have pre-programmed colour balance settings that 
compensate for different kinds of light. Typical settings include cloudy, shaded, 
incandescent, flash, fluorescent, and sunny. These settings compensate for the 
different colours of light likely to be present in those conditions, and should 
produce pictures that require little or no colour correction. Read your camera’s 
manual to find out about specific white balance settings it offers.

With film cameras, there is no way the camera itself can compensate for 
different lighting conditions. But there are two ways you can compensate for 
the coloured light: 

• Use film designed for specific lighting situations. Tungsten-balanced 
films, for example, help to neutralise the colour of tungsten or halogen 
illumination.

• Use a filter on your camera lens. For example, if you’re using daylight-
balanced film but want to take pictures indoors, you can use a blue-
coloured filter to absorb the overriding yellows and reds of the indoor 
incandescent lights.

Setting the white 
balance manually
Some digital cameras 
offer manual white 
balance control. This 
feature allows you to 
set the white balance 
by focusing on a pure 
white object, such as a 
piece of paper, and then 
locking down the white 
balance before you take 
the photo. 
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Using Automatic Modes on Your Camera 
Many of the automatic cameras sold today—even some of the less-expensive 
models—have pre-programmed modes that are designed for special situations. 
Sometimes called program modes, these modes automatically adjust your 
camera to special settings designed specifically for things like macro 
photography, action shots, portraits, panoramic mode, or picture series. 

If you’re a beginning photographer and are not always confident enough to 
adjust your camera’s manual settings, use the automatic modes to help you take 
better pictures. 

If your camera does not allow you to adjust settings manually, the automatic 
modes might produce the most successful pictures in these situations. 

The following sections describe the most common automatic modes available 
on many digital and film cameras. Since the type and implementation of 
automatic modes vary for each camera, read your camera’s manual for 
availability and usage instructions.
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Macro Mode
Most cameras in automatic mode have trouble focusing on objects that are less 
than 12 inches (30 centimetres) away. So when you’re taking close-up pictures, 
for example, capturing a special piece from your coin collection, you need 
to set your camera to macro mode. Macro mode adjusts the focal length to 
accommodate the unusually short distance to the subject.

Macro mode usually reduces aperture, which widens the depth of field, and 
increases the chances that the whole subject is in focus.

The camera’s macro mode was used to capture the fine detail of the jewellery.

When using macro mode, make sure to turn off the flash, since the flash does 
not provide proper illumination at such close range. Tripods are a good way to 
keep the camera steady for a close-up shot. If you don’t have a tripod, set the 
camera on a firm surface, focus the picture, and then activate the shutter with 
the self-timer.
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Action Mode 
If you’re photographing subjects such as athletes, moving cars, or even 
fast-moving children, a camera’s action mode helps keep your subject in 
focus. The most significant characteristic of action mode is the faster shutter 
speed of at least 1/500th of a second, which helps to freeze the action of your 
moving subject. The action mode in most cameras also uses a wider aperture 
setting (to offset the fast shutter speed), and multipattern light metering, which 
compensates for overly bright and overly dark areas.   

Action mode uses a fast shutter speed to freeze the action of a fast-moving subject.

Digital cameras create a unique challenge for action photography: the time 
lag between when you press the shutter button and the actual exposure. With 
film cameras, pressing the shutter button causes the shutter to open virtually 
simultaneously. But some digital cameras are much slower and you might have 
to wait as long as a second before the picture is taken. When photographing 
moving objects, one second can seem like an eternity. 

One way to compensate for the shutter lag is to anticipate your shot. Imagine 
you are photographing a runner with a camera that has a lengthy shutter lag. 
(The shutter lag will not be highlighted on the camera’s packaging, but you 
can figure it out through your own experience.) First, focus your camera on 
a spot that the runner will cross in about 10 seconds. When the runner is 
approximately one second away from your target spot, press the shutter button. 
The exposure should occur just as the runner comes into your field of focus. 

When the lag is 
a drag
Some digital cameras 
have a much shorter 
shutter lag than others. 
You might want to 
consider this factor 
when buying your 
next camera.
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Another way to photograph a moving subject is to pan your camera with the 
action. While a stop-action photo freezes everything in the photo, panning 
your camera keeps your moving subject in focus, but blurs the background. For 
this effect, you do not want to use the action mode, because you do not want a 
fast shutter speed. To accomplish this effect, follow your moving subject in the 
viewfinder (or LCD screen) as it moves, but pan the camera so that your subject 
remains in the same position in the frame. Your result won’t show the subject in 
as clear a focus as stop action, but the blurred background helps to pronounce 
the speed and movement of your subject.

Since the camera panned with the subject, the girl is in fairly sharp 
focus and the background is blurred. This helps convey movement.
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Burst Mode
Burst mode is a feature that allows you to take a series of pictures in quick 
succession. Many cameras include a burst mode that allows you to take a series 
of pictures in quick succession, such as 3 frames per second for up to five 
seconds.

Even on digital cameras with slow shutter lags, the burst mode still allows you 
to take many frames in a short time span. The burst feature uses a buffer to 
temporarily hold the information from the image sensor. After the maximum 
number of frames is stored in the buffer, the camera processes each frame 
separately and sends them to the removable storage media.

If your camera has a burst mode feature, you can use it to overcome the 
slowness of the shutter lag. When photographing a child, for example, it can be 
hard to get the child to pay attention for the few seconds that it takes to take the 
picture. But with burst mode, you might be able to shoot 10 frames within 10 
seconds. During those 10 seconds, you can encourage the child to talk, look at 
the camera, and make different movements and expressions. It’s doubtful that 
all 10 exposures will turn out to be great pictures, but you’re much more likely 

to get at least one good shot than if you’d just taken a single frame.

Another great use of the burst mode feature is to take an action sequence. 
Create a series of pictures of a golf swing, a child riding a bike, or a pet moving 
across the yard. Then you can assemble the whole series in a slide show, or 
mount the pictures together in a frame. 



111Chapter 12: Taking Great Pictures

Microsoft® Digital Image 2006 Standard Edition User’s Manual 

Portrait Mode
For portraits and candid shots, using your camera’s portrait mode is a 
convenient way to get good results. Portrait mode is set to use a relatively wide 
aperture, creating a shallow depth of field. With only your subject in focus, 
objects in the background are less distracting, and your subject dominates the 
frame. 

With a shallow depth of field, it’s crucial that you get your subject in sharp 
focus. If your depth of field is so short that you can’t focus on every part of your 
subject at the same time, focus on the subject’s eyes, and let hands and feet be 
in less focus. 

For this portrait, the Diffuse Glow filter was applied in Microsoft Digital Image to soften the 
focus.

For successful portraits, remember to fill the frame, and use a medium 
telephoto lens (around 105mm, or zoomed about halfway between wide angle 
and maximum telephoto). Keep the background very simple, unless you are 
using objects in the background as context for your subject. If you are taking 
pictures indoors, an off-camera flash or other light source works best. 

Relaxing your 
subject
An important 
aspect of portrait 
photography is to get 
your subject relaxed 
and comfortable for 
the pose. Try using 
conversation or other 
pleasant distractions to 
get your subject’s mind 
away from the camera.
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Panoramic Mode
For landscapes, large groups of people, and other long horizontal shots, a 
camera’s panoramic mode helps you compose the picture without too much 
sky or ground in the photo. Panoramic shots have a different aspect ratio from 
standard shots, meaning the width of the frame is proportionally much greater 
than in a picture with a standard aspect ratio. 

Some panoramic cameras take pictures with an aspect ratio of 4:11 (four units 
tall by 11 units wide), compared to the aspect ratio of 3:4 for standard shots on 
most digital cameras. As with the shape of a cinema screen versus a television 
screen, the wider frame gives you some new creative territory when composing 
your photo. 

Switching your camera to panoramic mode gives you new compositional possibilities.

True panoramic cameras use a wide-angle lens to let you capture more width 
of the scene by staying in the same position. Many cameras, including digital 
cameras and APS cameras, offer a panoramic mode without a wide-angle lens. 
Instead, the panoramic effect is achieved by simply cropping off the top and 
bottom of the frame. This type of panoramic shot does give you a wider aspect 
ratio, but not a wider angle. On some digital cameras, using the panoramic 
mode means that each photo has fewer pixels (since the top and bottom are 
cropped), so each panoramic shot takes up less space on your storage media.  
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Using the Self-Timer
Many digital cameras, even inexpensive ones, come with a self-timer feature. 
Some self-timers open the shutter after a preset amount of time, such as 10 
seconds; others allow you to adjust the length of time before the shutter fires. 
Either way, this fairly simple feature is great for getting yourself into a photo 
and taking long exposure shots.

Getting Yourself into a Picture
To get yourself into a picture, plan where you want to position yourself for the 
shot. Then set up the camera by putting it on a tripod, a table, or any other flat, 
stable surface. With your camera in position, focus the camera on your subject, 
which should be close to the position where you will stand for the picture. 

If your camera has autofocus, press the shutter halfway down to focus, press the 
self-timer button, and then press the shutter all the way down. Then you’ve got 
about 10 seconds to get yourself in position for the shot. 

Taking Long Exposure Shots
Another great use of the self-timer is for exposures with a relatively slow 
shutter speed. For speeds slower than 1/30th of a second, there is a good chance 
the slight movements in your hands will cause blurring in your picture. Even 
if you have very steady hands, the slight movement of your finger pressing the 
shutter button can create movement. Using the self-timer will eliminate this 
problem. By setting the camera on a tripod or firm surface and using the timer, 
your hands don’t have to be anywhere near the camera while the shutter is open.

Creating a 
makeshift tripod
If you’re outdoors, try 
propping the camera 
on a rock or car roof. 
Then fine-tune the 
positioning by putting 
the camera on a jacket 
or other object that you 
can shape to adjust the 
camera angle. 
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Ten Tips for Great Pictures
The following 10 tips offer suggestions for developing your photography 
approach, technique, composition, and habits. If you are an inexperienced 
photographer, some of these tips might be new ideas for you. If you’re a 
photography veteran, these tips might be a good reminder of things you haven’t 
heard in a while.

1. Know Your Gear
Having command of your equipment is an important aspect of enjoying and 
being successful with photography. As you get to know your gear and gain 
confidence in a camera’s capabilities, the camera can become an extension of 
yourself. When you have reached this level of competence, you can concentrate 
more on the creative aspects of photography. 

When you get a new camera, read the manual. With digital cameras especially, 
operating the controls might not be intuitive, since many digital cameras’ 
controls must be accessed through menus on the LCD screen.  

After you’ve read the manual and understand how and when to use your 
camera’s features, go out and take a variety of pictures using the different 
settings. Take some pictures outdoors and indoors, with the flash and without 
the flash, with automatic settings and with manual settings. As you take 
pictures, take notes to record the settings used for each picture. Later, look at 
your photos and take note of both the settings that worked well and the settings 
that produced poor results. 

Missing a great photo because of worrying about technical issues is 
frustrating. Spend time getting to know your gear and prepare for great 
photo opportunities. 



115Chapter 12: Taking Great Pictures

Microsoft® Digital Image 2006 Standard Edition User’s Manual 

2. Perfect Exposures
In a finished photo, exposure is something that you usually only notice when 
it is wrong. A perfect exposure is not something that jumps out at you, but a 
problem exposure definitely stands out. In an overexposed picture (caused by 
too much light), the shadow areas are light, and the highlighted areas are almost 
entirely white. In an underexposed picture, too little light has been let into the 
camera, creating a photo that lacks detail, with filled-in shadow areas and dull 
highlighted areas.

Special lighting situations can fool the built-in light meter in your camera. 
If you want to start with the camera’s automatic exposure, use exposure 
compensation to fine-tune the exposure. The following list describes some 
common lighting problems and the recommended exposure compensation for 
each: 

• For a side-lit subject: increase exposure by one half of a stop.
• For a backlit subject: increase the exposure by one stop. Or step in close 

and meter directly on the subject, step back and recompose, and then take 
the picture at the reading you took on the subject. You can also switch to 
spot metering.

• For a small dark subject against a bright background, or any subject in 
a very bright scene: use exposure compensation of +1 to +3, or increase 
exposure by one to two stops, for example, from f/8 to f/5.6 or f/4.5.

• For a small, light subject against a dark background: use exposure 
compensation of -1, or decrease exposure by one stop, for example, from 
f/8 to f/11.

Planning for the 
imperfect
Learning to get the 
perfect exposure takes 
a lot of experience, 
and no one gets it 
right with every shot. 
If you suspect the 
lighting might make 
it difficult to get the 
correct exposure, you 
can increase your 
chances of success by 
bracketing.
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3. Capture a Moment in the Story
Consider driving licence and passport photos. We think of these as 
uninteresting and unrepresentative of how people usually look. Why are these 
photos dull?

One problem with these photos (but certainly not the only problem) is that 
they capture people out of their element, without context or a story. There are 
no interesting details in the background to draw in the viewer, and the subject 
often looks impatient or uncomfortable.

When you are the photographer, you can strive to capture people, events, and 
places that tell a story. In addition to getting your subject to look natural and 
not posed, details in front of the subject or in the background can stimulate the 
imagination to re-create the story of the photo. 

This photo captures the destruction of an earthquake just hours after the event. Since the 
photo was taken before the rubble was cleared away, the photographer was able to capture 
the many details of the scene that tell the story.

With enough of these details, and a strong relationship between your subject 
and the other elements, the photo can suggest ideas that are not even in the 
frame. You can take the old cliché “A picture paints a thousand words,” and 
make it your goal to paint more than a thousand words with your photographs.     
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4. Look for the Light
Many of the best  pictures are taken early in the morning, late in the afternoon, 
and at twilight. At these times the lighting is most dramatic.

Many pictures are shot in bright or moderately bright sunlight. This type of 
light produces photos that closely match the way we remember seeing the 
scene. That is part of the reason we respond to them with a positive sense of 
familiarity.

However, colours photographed in the cooler light at twilight or in overcast 
conditions, or in the warmer light of sunrise and sunset, offer a new perspective 
on familiar colours and subjects, and provide a more creative backdrop for 
photographs. Overcast and after-the-rain conditions, in particular, produce 
richer, more saturated colours. For example, red leaves photographed against 
a twilight backdrop, instead of in daylight, create a moody interpretation that 
suggests a sense of mystery or drama.

For interior pictures, look for strong sources of natural light, as from a window 
or a skylight. The glow of light coming from one direction can illuminate your 
subject dramatically.
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5. Follow the Rule of Thirds
When composing a photograph, many beginning photographers always centre 
their subject directly in the middle of the frame. While this technique might be 
the easiest way to get the subject in focus with a point-and-shoot camera, it is 
not always the most interesting way to present the subject. 

Most advanced photographers follow the rule of thirds when composing the 
space inside a picture frame. The rule of thirds divides the frame into thirds 
both horizontally and vertically, and places the point of interest on one of 
the four spots where these dividing lines intersect. The rule of thirds is used 
throughout the graphic design world, because it helps to create balance between 
the subject and the background.

To apply the rule of thirds, divide your scene into three sections horizontally and vertically. 
Place the focal point of your photo on one of the intersections of the dividing lines. 

Following the rule of thirds, the bicycle in this photo lies on the points where the dividing lines 
intersect. The top of the dock also roughly follows the horizontal line that runs one-third down 
from the top of the frame.

Recomposing 
a photo with 
Microsoft Digital 
Image
After a photo has been 
transferred to your 
computer, use the 
crop tool in Microsoft 
Digital Image to change 
the composition. By 
clipping away the edges 
of the photo, you can 
reposition your subject 
to comply with the rule 
of thirds. 
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If you have a person or animal in your picture, you can place the subject’s face 
on one of the four points, looking towards the centre of the scene. If the horizon 
is in a picture, it should run about one-third from the top or one-third from the 
bottom, depending on whether the terrain or the sky is the centre of focus.

The rule of thirds is not an absolute law, and there have been many great 
pictures taken that don’t abide by it. But the rule can be a great way to add 
balance and interest to your pictures.

6. Find a Unique Perspective
You can challenge yourself to take original pictures that convey unique 
perspectives. Rather than just pressing your shutter button as soon as you 
have the urge to capture a scene, take some time to assess your camera angle, 
proximity to your subject, and background elements. You might transform your 
composition by taking one or more of the following simple steps:

• Get closer to your subject to show more detail and eliminate distractions 
in the background.

• Include just a portion of your subject in the frame.
• Take your original subject and place it in the background. Find a new 

subject that adds context to the object in the background.
• Get lower to the ground, and point the camera up towards your subject.
• Move to a higher location, above your subject, so you are pointing down 

when you take the photo.

For example, if you are travelling, your natural instinct might be to take 
straightforward pictures of local monuments. But with this approach, you might 
end up with the same lacklustre pictures taken by scores of other tourists before 
you. And there would be a good chance that a nearby souvenir shop would sell 
superior, professionally photographed prints and slides of the same monuments. 
For that matter, you could have just stayed at home and ordered the photos from 
a professional.

Use your imagination to compose some original, creative photos that you 
won’t find anywhere else. Capture some of the local colour by photographing 
a lively food vendor stationed near the monument, and the monument can be 
the backdrop in your frame. Or use the self-timer to capture you and your 
companion sampling the local fare that you’ve bought from the food vendor in 
front of the monument.  
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7. Bracket
The term bracket means to create exposures that are both lighter and darker 
than the camera or light meter indicates. The idea is to second guess the purely 
mechanical exposure meter, so that you get the right exposure. 

If you’re taking photos of a sunset, a scenic vista, or a plant, you have the time 
to bracket. With these subjects, you’re also likely to have a wider range of tones 
to record than your camera can handle, especially if your subject is brightly lit. 

So how do you bracket with an automatic camera? Most digital cameras, and 
many automatic cameras, have an exposure compensation feature, sometimes 
called the EV setting. If you set the exposure compensation for -1, the shot 
is one stop underexposed (darker than normal). If you set the camera for +1, 
the shot is one stop overexposed (lighter than normal). So you can bracket by 
taking three pictures, one each at the -1, 0, and +1 settings.

Some cameras offer an automatic feature, which takes a range of photos, each 
with a different exposure setting.

Even if your camera doesn’t permit you that much control (or if you don’t want 
to take the time to change the exposure settings), another technique will give 
you results similar to bracketing. To get a lighter exposure, aim your camera at 
a darker portion of the subject, and then press the shutter button part way down 
(until you begin to feel a little resistance). Next, without releasing pressure on 
the shutter button, reframe your photo to include what you want, and then push 
the shutter button all the way down to take the photo. 

This technique will only work if pressing the shutter button halfway down 
locks in the exposure, so you might want to check your camera’s manual to 
be sure. You will also need to set the exposure on an object that is roughly the 
same distance away from the camera as the subject. Otherwise, your subject 
will not be in focus when you take the picture.   
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8. Analyse and Try Again
Photography takes practice. And you will progress at a faster rate if some of 
your practice time is focused on developing specific skills. One way to do that 
is to analyse your pictures and then take them again.

When you get a chance to look at your pictures on a computer or as prints, you 
can assess their quality of composition, lighting, exposure, and white balance. 
Upon close inspection, you might realise that you placed your subject too close 
to the centre of the frame, or that incandescent lights caused an orange glow. 
The next time you’re taking pictures, take this same photo again, and make 
adjustments for the problems you encountered before. 

When you look at the results of your second round of pictures, you might find 
that you got excellent results, or you might find that one of your adjustments 
disrupted something else in the photo. Or maybe the different lighting 
conditions of the different day made it more difficult to get the perfect 
exposure.

To continue the exercise, photograph the same subject or scene on a regular 
basis. You must always compensate for the differences in lighting each day, but 
you can try new approaches to the composition. Learning to photograph the 
same subject under different conditions or with a different approach gives you 
valuable experience and ideas when you encounter new situations.

9. Take Pictures Every Day
To become a talented and confident photographer, make photography part 
of your daily routine. Fortunately, digital cameras have made it much more 
convenient and inexpensive to take lots and lots of pictures. Once you’ve 
purchased your digital camera, you can take as many photos as you want. The 
only cost is for batteries and storage for your pictures.

The more you practise, the more confident you’ll become in your skills and in 
your equipment. You’ll also develop the habit of keeping your camera close by, 
and having it ready for photo opportunities. Train yourself to look for these 
opportunities, and take advantage of them when they come to you. Some of 
the world’s most memorable pictures were taken by amateur photographers 
who happened to be in the right place at the right time. So to be ready to take 
that once-in-a-lifetime shot, know how to use your gear, have your equipment 
handy, and be on the lookout for great photo material.

A quick check 
with the LCD
One of the benefits of 
digital photography 
is that you can get a 
look at your photos 
on the LCD preview 
screen right after you’ve 
taken the shot. This 
feature is great for a 
quick analysis of the 
photo’s composition, 
exposure, and colour 
tone. Because preview 
screen is so small, 
however, it often does 
not reveal problems 
with focus.  
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10. Show Your Pictures to Other People 
Even when you are making great progress with your photography skills, it’s 
easy to overlook the shortcomings in your own work. To continue improving 
your abilities, show your photos to other people. Getting others’ opinions is an 
invaluable learning experience. 

Good pictures should be visually exciting to people, eliciting a “Wow, this is 
great!” response. If you find that people are not very excited by your photos, ask 
them what they think is missing, and what you could do to make them better. 
You’ll be surprised what some people like and do not like about your pictures.

Find other photographers in your community. You can look at each others’ work 
and give feedback. This kind of mutually beneficial arrangement also helps you 
to develop your critical eye.

While it’s important to show your photos to others, remember that you are the 
ultimate judge of your own work. Photography is an art and, as an artist, you 
should establish your own voice and style. You don’t have to listen to every 
piece of advice, and you might produce your best work by taking chances and 
following your own instincts.

That said, photographs are made to be seen! As you improve you photography 
skills, showing off your photos can be the best part.  
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preserving object groups  39
preserving object layers  40
printers

colour management  67
drivers  65
quality settings  67
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printing pictures
alignment on page  65
cropping  33
maximum sizes  87
multiple images  66
paper options  68
quality settings  67
resolution  87, , 87
single image  65
size  67
 Digital Image   66
 Microsoft Digital Image   66

prints, ordering  69
prints\\, ordering  69
program modes. See automatic camera 

modes; See automatic camera modes; 
See automatic camera modes

projects, creating photo  57
projects\\, creating photo  57
proportional cropping  33
proportional resizing  37
PSD files  10

Q
quality enhancements. See editing pic-

tures; See editing pictures; See editing 
pictures

quality ranges, printer  67
quality ranges\\, printer  67
quarter-fold cards  57

R
ratings, grouping by  80
rechargeable batteries  93
rectangles  42
reducing photo size  89
red eye  31, 95
reinstalling Digital Image  4
reinstalling Microsoft Digital Image  4
removable media  92
removing

Digital Image  4
Microsoft Digital Image  4

picture features  44
renaming batches  83
reordering objects  35
resizing

batches  83
picture cropping  33
picture features  37
thumbnails  78

resolution
cropping  33
e-mail quality  64
overview  87
print size  67
Web quality  64

rotating picture features  37
rubber stamp effects  49
rule of thirds  34, 118

S
saving pictures  61
scanners

opening pictures from  12
selection tools

Edge Finder  44
freehand  43
Magic Wand  45
marquee  42
object  37
overview  41

self-timer features  113
sending prints or gifts  69
sensitivity camera setting  104
sepia tones  48
series, photo  110, 
shadows  96
sharpening pictures  47
sharp prints  67
showing screen items  80
shrinking picture to show edge  55
shutter lag  108
shutter priority mode  103
shutter speeds  102
single picture printing  65

size
batches  83
e-mails  64
file compression  89
flattened PNG files  63
odd-sized pictures, mats for  56
picture cropping  33
picture features  37
prints  67, 87
storage media  92
thumbnails  78

SLR (single-lens reflex) cameras  97, 
smaller print sizes  67
small aperture  100
SmartMedia card  92
soft edge effect  55
special effects. See also objects

colours  48
filters  47
freehand  49
stamps  49

splotchy colour  89, 
Stack  35
stained glass filter  47
stamps, painting with  49
storage media  7, 92
storing information. See Microsoft 

Digital Image Library
stretching picture features  37
sunlight  96

T
table of contents  80
temporary object links  38
TGA files  10
thumbnails

objects  35
resizing  78
viewing options  79

Thumbnail pane
grouping pictures  80
hiding/showing items  80
view options  79
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 Preview pane  81
thumbnail slider  78
TIF files  10, 62
tiles view  79
time

shutter lags  108
viewing pictures by  77

tint adjustments  30
toolsets. See color and saturation or 

exposure and lighting
touch-up tools  29
touching up pictures.  See editing 

pictures
touchup tools  29
tracking information. See Microsoft 

Digital Image Library
transferring files

importing  7
tripod substitutes  113
TWAIN  11

U
underexposure  97
ungrouping objects  39
unlocking objects  36
unprintable card areas  57
upgrading Digital Image  3
upgrading Microsoft Digital Image  3
USB Mass Storage Class devices  8

V
viewing pictures by

dates  77
folders  77
keywords  76
overview  76
thumbnails  79

viewing picture information  81
viewing thumbnails  79

virtual drives  8

W
water glass analogy  98
Web quality resolutions  64
weight ranges, paper  68
Welcome to Microsoft Digital Image 

Premium Library window  72
white balance  30, 105
WIA  11
wide aperture  100
Windows Bitmap files  10
Windows Metafile files  10
wizards

Import Pictures  7
Installation  2

Y
year, viewing pictures by  77

Z
zoom  91
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